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Foreword
Thank you for purchasing the YOKOGAWA VK9000 1394 Data Analyzer.  This user’s

manual contains useful information about systems functions, operating procedures, and

troubleshooting tips.  To ensure correct use, read the manual thoroughly before

operation.  Keep this manual in a safe place for quick reference in the event of a

question or utilize the system’s online help.

Notes
• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the instrument’s performance and functions.

• Every effort has been made in the preparation of this manual to ensure the accuracy

of its contents.  However, should you have any questions or find any errors, please

contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without

YOKOGAWA’S permission is strictly prohibited.

• YOKOGAWA holds the copyrights to the software of this product.  Altering, copying,

and reverse engineering all or any part of the software is strictly prohibited.

Trademarks
Company and product names that appear in this manual are trademarks or registered

trademarks of their respective holders.

Revisions
1st Edition: February 2001

Disk No. ????

1st Edition : February 2001 (YK)

All Rights Reserved, Copyright © 2001 Yokogawa Electric Corporation



ii IM 703425-01E

Checking the Contents of the Package

Unpack the box and check the contents before operating the instrument.  If some of the

contents are not correct or missing or if there is physical damage, contact your

YOKOGAWA dealer.

VK9000
Check that the model name and suffix code given on the nameplate match those on the

order.

MODEL (Type Name) and SUFFIX (Suffix Code)

Type Suffix Code Description

703425 VK9000

/D1 or /F1 SBP-2 Parser
/D2 or /F2 AV/C Parser
/D3 or /F3 IPv4 over 1394 Parser
/D4 or /F4 Scripting Software
/D5 or /F5 HAVi Software
/D6 or /F6 Customize Parser

Standard Accessories

Part Name Quantity

VK9000 unit 1

Cordless keyboard 1

Mouse 1

Batteries 2

Stylus 1

1394 Cable 1

Power cord 1

CD-ROM containing backup software 1

Windows NT software 1

CD-ROM containing backup PC 1

User’s guide 1

License sheet 1 (In the case of the option addition)
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Safety Precautions

This instrument is an IEC safety class I instrument (provided with terminal for protective

grounding).

The following general safety precautions must be observed during all phases of

operation.  If the instrument is used in a manner not specified in this manual, the

protection provided by the instrument may be impaired.  YOKOGAWA Electric

Corporation assumes no liability for the customer’s failure to comply with these

requirements.

Make sure to comply with the following safety precautions.  Not complying might

result in injury or death.

WARNING

Power Supply
Ensure that the source voltage matches the voltage of the power supply
before turning ON the power.
Power Cord and Plug
To prevent an electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA.  The main power plug must be plugged into an
outlet with a protective grounding terminal.  Do not invalidate this

protection by using an extension cord without protective grounding.
Protective Grounding
Make sure to connect the protective grounding to prevent electric shock
before turning ON the power.

Necessity of Protective Grounding
Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal.  Doing so poses

a potential shock hazard.
Defect of Protective Grounding
Do not operate the instrument when the protective grounding or the fuse

might be defective.  Also, make sure to check them before operation.
Do Not Operate in Explosive Atmosphere
Do not operate the instrument in the presence of flammable liquids or

vapors.  Operation in such environments is very dangerous.
Do Not Remove Covers
Some areas inside the instrument have high voltage.  The cover should be

removed by YOKOGAWA’S qualified service personnel only.
External Connection
Connect the protective grounding before connecting to the item under

measurement or to an external control unit.
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Safety Precautions

CAUTION

This product is a class B1 product (for the measurement room).

Operation of this product in a residential or commercial area may cause
interference to other equipment.
Any unused ISA and PCI slots of the instrument cannot be used.

YOKOGAWA does not guarantee proper operation if the user adds card or
modifies the unit.
The instrument may have an adverse effect on a device connected to the

same AC power supply due to the power supply’s distorted harmonic
signals.
The instrument uses a lithium battery.  When the battery dies, please

contact your nearest YOKOGAWA dealer as listed on the back cover of
this manual.
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1.1 Characteristics of VK900

The VK9000 is a 1394 testing solution and provides complete 1394 data analysis and

generation. Analyze 1394 serial bus activity using the VK9000, a powerful and flexible

way to analyze your 1394 bus. View node configuration information and set flexible

triggers to capture and filter data.  Generate 1394 traffic and examine CSR data.

The VK9000 provides a complete, cost effective, 1394 testing suite. Use the VK9000 to

set triggers, generate and capture data, or analyze packet contents and bus topology.

Importantly, snooping and packet generation is supported at speeds of 100, 200, and

400 Mbps.  Optional plug-in support includes AV/C, IPv4, SBP-2, HAVi and scripting.

Some of the major features and capabilities are:

• Fully compliant with 1394-1995 and 1394.a

• Topology map for bus topology analysis

• Snooping and packet generation at speeds of 100, 200, and 400 Mbps

• Optional protocol support includes AV/C, IPv4 SBP-2, and HAVi

• Optional scripting engine

• Optional Customize protocol parser function

• Node identification and speed mapping

• View CSR information

• Event Window for display of traffic

• Flexible triggering

• External Trigger In/Out

• 2–six-pin 1394 connectors and 1–four-pin 1394 connector

• Comprehensive filtering

• Event search engine

• 1394 packet generation

• Statistical data analysis

Chapter 1 Introduction to VK9000
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1.2 Structure of the Manual

This manual provides detailed information on functions of the VK9000 via procedural

steps and descriptions and definitions of VK9000 functionality. Use the VK9000

Instruction Manual as a reference for specific procedural steps or background

information. This manual also provides overview information on major, high-level

functions of the VK9000 via user interface information and tutorial information.

The manual is divided into eleven major sections:

Front Matter

The Front Matter includes the VK9000 Model Number and Suffix Codes along with

package contents and general safety precautions.

Chapter One: Introduction to VK9000

The Introduction to VK9000 discusses important overview information including a

summary of system features and a review of the contents of this manual, a description of

labeling conventions and notations used in the manual, and important safety

precautions.

Chapter Two: Getting Started

The Getting Started chapter, discusses information needed before first using the VK9000

including setting up the system for the first time and includes information on the VK9000

User Interface including menus, commands, shortcut icons, customization tips, and the

soft keyboard for data entry. Also this section contains a Quick Tour, which provides

several tutorial steps to increase users’ familiarity with the interface and highlights basic

functions of the VK9000.

Chapter Three: Topology Window

The Topology Window section examines the major functions related to visualizing the

1394 bus including the Topology Map for viewing 1394 nodes on the bus including

performing Read, Write, and Lock commands, the Event List for viewing individual 1394

packets, the Transaction Viewer for tracing 1394 transactions between nodes on the

bus, and consumed 1394 bandwidth.

Chapter Four: Capturing Packets

The Capturing Packets section discusses capture buffer organization and triggering and

capturing options including setting, saving and reusing triggers and trigger condition

options including external in and external out triggering via the BNC connector.

Chapter Five: Examining Node and Packet Contents

The Examining Node and Packet Contents section examines the CSR and Config ROM

Explorer, which is used to examin CSR and Config ROM data with packet contents

numerical values translated in descriptions in a tabular format, and the Data Explorer,

which is used to selectively examine packets from the capture buffer and drill down and

examine contents and parse various protocols.

Chapter Six: Generating 1394 Traffic

The fifth section, Generating 1394 Traffic, discusses various packet generation options

for asynchronous, isochronous, PHY, and higher level protocol packets including

simultaneously generating and triggering on packets.  The section also details creating

sequences of packets and saving and reusing packets.
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1.2  Structure of the Manual

Chapter Seven: Additional VK9000 Software Functionality: Custom Protocol Plug-

In and Scripting Engine

The Additional VK9000 Software Functionality: Custom Protocol Plug-In and Scripting

Engine chapter discusses the Custom Protocol Plug-In, which provides a method to

define a custom protocol and then the ability to parse a 1394 packet to reveal the user

defined protocol.  Also discussed is the Scripting Engine Plug-In, which is an embedded

Visual Basic Scripting Engine that uses standard VB commands and VB Language

Extensions for VK9000 specific commands for automating much of the development and

testing process.

Chapter Eight: Contacting Customer Support, Backup Software Installation, and

Troubleshooting Tips

The Contacting Customer Support, Backup Software Installation, and Troubleshooting

Tips section contains important information on contacting customer support and the

VK9000’s operating system and its system software along with common troubleshooting

tips for the LCD Monitor, keyboard and touchscreen, and the Topology Map.

Chapter Nine: VK9000 Specification

The VK9000 Specification section contains a detailed specification for the unit.

Appendix

The Appendices section contains information on protocol support detection values and

reference information.

Description and Labeling Conventions
The documentation uses common Microsoft labeling conventions for graphical user

interface elements such as windows, menus, menu items, icons, task bars, dialog boxes,

tabs, etc.   Familiarity with the exact conventions is not necessary.  The documentation is

designed to emphasize Yokogawa interface elements, not labeling terms.  To help users

focus on these elements, Yokogawa graphical user interface element titles are in bold

type in the documentation, for instance, Data Generator window.   Also when a short-cut

button command is available the documentation first outlines using the menu command

then provides the short-cut as a Tip after the main procedural step.

The VK9000 is designed for mouse or stylus pen operation.  Thus users can either use a

mouse or a stylus to interact with the user interface.  To avoid confusion the manual

uses terms for mouse actions such as click and double-click instead of terms specific to

stylus pen/touchscreen operation such as tap and double-tap.  In either case the term

click and tap are interchangeable; that is click means the same as tap throughout the

manual.  A user would for instance move the tip of the stylus pen to the object in

question and press it once or twice for double click.
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1.2  Structure of the Manual

Notations Used in this Manual
The following notations are used in this manual:

Hexadecimal notation (Example) 012316  0x0123 (Hex): 0123

Decimal notation (Example) 123

Binary notation (Example) 110112

Precautions
Handling of packets that do not conform to the standard

The capture operation is not guaranteed when packets that do not conform to the

standard are received.

Analyzer operation when software or hardware other than the analyzer is installed

YOKOGAWA will not be held responsible for operation problems of the analyzer that

may occur if the user installs software or hardware that was not installed at the time of

delivery of the product.

The operation of the software and hardware other than the analyzer when it is

installed

If the user installs software or hardware that was not installed at the time of delivery of

the product, YOKOGAWA will not be held responsible for the operation of the software or

the hardware.
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2.1 Safety Precautions

If you are using this instrument for the first time, make sure to thoroughly read the Safety

Precautions section at the start of this manual.

Do not remove the cover from the instrument

Some sections inside the instrument have high voltages that are extremely dangerous.

For internal inspection or adjustment, contact your nearest YOKOGAWA dealer as listed

on the back cover of this manual.

Malfunction

Never continue to use the instrument if there are any symptoms of trouble such as

strange smells or smoke coming from the instrument.  In such cases, immediately turn

OFF the power and unplug the power cord.  Then, contact your nearest YOKOGAWA

dealer as listed on the back cover of this manual.

Power Cord

Nothing should be placed on top of the power cord.  The power cord should also be kept

away from any heat sources.  When unplugging the power cord from the outlet, never

pull the cord itself.  Always hold the plug and pull it.  If the power cord is damaged,

contact your dealer for replacement.

Chapter 2 Getting Started
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2.2 General Handling Precautions

Never place anything on top of the instrument

Never place another instrument or any objects containing water on top of the instrument.

This may cause problems.

Do not apply shock to the input section

Applying shock to the input terminal or the connected cable can cause electrical noise to

enter the instrument.

Do not damage the LCD

The LCD is very vulnerable to scratches.  Therefore, be careful not to damage the

surface with sharp objects.  Also, do not apply vibration or shock to it.

When not using the instrument for a long time

When the instrument is not being used for an extended period of time, unplug the power

cord from the outlet.

When moving the instrument

First, disconnect the power and other cables.  Use both hands to carry the instrument.

Cleaning

When cleaning the case or the operation panel, first remove the power cord from the

outlet to prevent electrical shock.  Then, wipe with a dry, soft cloth.  Do not use volatile

chemicals since this might cause damage including but not limited to discoloration or

deformation.
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2.3 Installation Considerations

Installation position

Place the instrument on a flat, even surface making sure that the ventilation holes on the

back of the unit are not blocked.  To prevent internal overheating, allow enough space

around the instrument and do not block the vent holes.

Installation condition

Install the instrument in a place that meets the following conditions.

Do not install the instrument in the following places:

• In direct sunlight or near heat sources

• Near high voltage equipment or power lines

• Where an excessive amount of soot, steam, dust, or corrosive gases are present

• Near magnetic field sources

• Where the level of mechanical vibration is high

• In an unstable place
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2.4 Before Connecting the Power Cord

To avoid electrical shock and damage to the instrument:

Connect the power cord only after confirming that the voltage of the power supply

matches the rated electric power voltage of the instrument.

Connect the power cord after checking that the power switch of the instrument is turned

OFF.

To prevent electrical shock or fire, always use the power cord supplied by YOKOGAWA.

Always use protective grounding to prevent electrical shock.  Connect the power cord of

the instrument to a three-pole power outlet that has a protective grounding terminal.

Never use an extension cord that does not have protective grounding; otherwise the

protection function will be compromised.
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2.5 Setting Up

Connect the Power Cable
1. Check that the power switch is OFF.

2. Connect the plug of the accessory power cord to the power connector on the rear

panel of the instrument.

3. Plug the other end of the power cord into a power outlet

Install the Batteries in the Keyboard
Make sure that the batteries are installed in the keyboard.  If the unit will not be in use for

a long period, remove the batteries not avoid battery drain.  Also when traveling with the

unit consider removing the batteries to also avoid drainage which can occur if the mouse

button on the keyboard is depressed.  Connect the mouse.

Setting Networking Option
The VK9000 supports networking.  This option is not enabled when the unit is shipped

since each user’s site has different variables and constraints.  Consult with your network

administrator for configuring networking options.

Connect a 1394 device
To connect a 1394 device, connect a 1394 cable to one of the VK9000’s 1394 ports

located on the left side of the unit.  Connect the 1394 cable to the appropriate device.

Start the VK9000
Press the power switch located to the back of the main unit.  The VK9000 starts.

Using the VK9000 with a Stylus or a Mouse
The VK9000 supports mouse or stylus use.  The system is designed with a touchscreen

and ships with a VK9000 stylus/pen.  The stylus is operated by twisting the cap to reveal

the plastic tip or use with the interface or a ball-point pen tip for regular writing.

The keyboard mouse, which is the right-hand button on the keyboard, moves the mouse

pointer on the screen.  The double-button on the left-hand section of the keyboard are

used to select objects by single or double click actions.

WARNING

Do not use the pen tip or other types of sharp objects on the touchscreen.
Sharp objects can scratch or damage the screen.

The VK9000 also supports a serial or PS/2 mouse usage.
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VK9000 Physical Configuration Overview

F
G
N
O
P
Q
R

ABHSICJDKLEMTV

Item Description Item Description

A Printer port J External FDD

B COM1 K +5/12 V DC-out

C COM2 L DIO

D COM3 M DIO

E COM4 N TV-out (S-teminal)

F Ethernet (RJ45) O TV-out (RCA jack)

G VGA port P Line-in

H PS/2 Keyboard Q Speaker out

I PS/2 Mouse R MIC-in

2.5  Setting Up
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2.5  Setting Up

A

B

Item Description

A Floppy Drive

B CD-ROM Drive

A

B

C

D

Item Description

A BNC connector

B 1394 6-pin connector

C 1394 4-pin connector

D 1394 6-pin connector
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Structure of the VK9000 Default Folder
The various files used by the VK9000 are stored in folders under the directory c:\dpx.

The folders titles are:

Folder title Contents

Bitmaps Contains bitmap file data.

Data Contains capture data saved to a file and uses the file extension .fwx.

Firmware Contains files and information to update the VK9000’s firmware.

Framebuilder Contains data and files used by the Framebuilder Software which is used in
conjunction with the Custom Protocol Plug-In to build unique packets.

Icons Contains images used on the Topology Map to represent 1394 nodes.

Protocols Contains higher-level protocol information used by the Framebuilder and
VK9000.

Packets Contains packet data saved to a file including Asynchronous packets (.apk)
Asynchronous packet streams (.asq); Isochronous packets (.ipk); and PHY
packets (.ppk) and PHY packet streams (.psq).

Scripting Contains data and files used by the Scripting Engine Plug-In.

Settings Trigger condition files (.trg) and filter configuration files (.eft) are stored in this
folder.

The pdf data of this Instruction Manual is also stored in User’s Manual folder in backup

CD-ROM.

2.5  Setting Up
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2.6 VK9000 User Interface Tour

Menu Bar
The user interface for the VK9000 consists of four menu/button bars.  The top bar is the

Menu bar and is used to access submenu commands.

Menu Bar

Menu Item Description

File Contains commands used to manipulate data in the VK9000 user interface including
saving data and opening data along with preferences for node topology display.

View Contains commands used to determine how data is displayed in the Topology
window and Event List/Transaction Viewer.

Filter Contains commands used to selectively display different types of data from the
capture buffer.

Trigger Opens the Trigger window.  Trigger window is used to select data capture options.

Generator Opens the Data Generator window.  Data Generator window is used to select
preferences and options for 1394 packet generation

Zoom Contains commands to increase or decrease the Topology Map.

Tools Contains a commands for the Real Time Bandwidth Monitor, Soft Keyboard, and
Scripting Engine API.

Help Contains commands for displaying Online Help and displaying software revision
number.
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Button Bar
Directly under the Menu bar is the Button bar.  The Button bar is used to access shortcut

commands.   These commands are also accessed via submenus from the Menu bar.

Button Bar

Button Bar Shortcut Icons

Button Name Button Icon Button Description

New Clears current displayed topology.

Open Used to launch/access a new file.

Save Used to save to a file packet data.

Print Prints Topology

Print Preview Previews Print job.

Refresh Topology Updates displayed topology.

Update Port Status Updates node port status information.

Capture Opens the Trigger window.

Start Generation Opens the Data Generator window.

Stop Iso Generation Stops Isochronous packet generation.

Filter Opens the Filter window.

Live Topology Displays Live (active) bus topology.

Logged Topology Display Logged (captured/saved) topology.

Zoom In Increases Node Size.

Zoom Out Decreases Node Size.

Search Opens the Dialog for Searching Event window.

Scripting Starts the Scripting Engine API, optional feature.

Bandwidth Starts the Real time Bandwidth Monitor.

Help Opens the Online User Guide.

2.6  VK9000 User Interface Tour
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Topology Map
The Topology Map is located directly under the Menu and Button bars.  The Topology

Map shows live and logged 1394 bus topology.  Devices are represented as nodes on

the Topolgy Map.  The Topology Map when showing live or active topology uses red

as a background color for the window.  When the topology is saved or logged then the

background color changes to green.

Topology Map

Node Element Descripton

node Node Identification number.

spd Speed supported by the node.

link Displays the linkon bit value.  A value of 1 shows the link is on.

pwr Displays a node’s power class.

Node icon Icon displayed to represent the node.

Node name Name given to the node.

GUID Globally Unique Identifier number. Unique number assigned to 1394
devices.

Cap Node capabilities.  Abbreviations in Uppercase show that the node is acting
in that role, for instance BMC means that a node is acting as Bus Manager.

Prot Indicates protocols supported.

PHY ports Indicates the number of PHY ports on the node.

2.6  VK9000 User Interface Tour
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Event List and Transaction Viewer
Users can examine packet traffic in two ways.  The first method is the Event List in

which bus traffic from various nodes is detailed in a tabular format.  The Event List is

located below the Topology Map.

Event List

The second method, the Transaction Viewer, which represents bus packet details,

involves graphically representing packet traffic.  The Transaction Viewer is located in

the same place as the Event List on the Topology window.  Users select which view to

use and can toggle between each.

Transaction Viewer

Accessing the Event List and Transaction Viewer along with several other features is

made possible via the Navigation bar located below the Event List/Transaction

Viewer.  Users can select view options by clicking on the needed button.  Importantly,

these features examine packet details and will not display any information unless data

has been logged/captured or a saved file is opened.

2.6  VK9000 User Interface Tour
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Navigation Bar and Status Bar

Navigation Bar

Item Description

Topo/Event List Displays contents of the capture buffer/logged file in the Event List.

Transaction Displays the contents of the capture buffer/logged file in the Transaction
Viewer.

Bandwidth Displays the contents of the capture buffer/logged file in the Bandwidth
Usage window.

Transmit Time Displays the contents of the capture buffer/logged file in the Transmit Time
window.

Event Time Distribution Displays the contents of the capture buffer/logged file in the Event Time
Distribution window.

Statistics Displays the contents of the capture buffer/logged file in the Statistics
window—not a graphical presentation but a tabular summary.

The Status bar located in the lower right hand corner of the screen tracks several key

features including if a filter is applied, whether topology is live or logged, the status of the

Isochronous Generator, and if the Number key on the keyboard is selected.

Status Bar

Item Description

Filter Indicates whether a Filter is applied to the contents of the capture buffer/
logged file.

Topology Indicates if the topology is Live (active) or logged (contents of capture
buffer/logged file).

Generator Indicates whether the Isochronous Generator is active.

NUM Indicates if the Num Lock key on the keyboard is selected.

2.6  VK9000 User Interface Tour
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File Menu
The File menu contains commands used to open previously saved files and select

preferences, which alter the displayed topology.

File Menu

Item Description

New Clears current topology.

Open Used to access data saved to a file.

Save Used to save data to a file.

Save As Used to save data to a file or change data already saved to a file.

Save a Portion As Used to select a section of the Event List/Transaction Viewer to
save to a file.

Save Topology as (BMP) Save to a bitmap file node data displayed on the Topology Map.

Save Event List as (CSV) Save to a CSV file data in the capture buffer/logged topology.

Print Prints current topology.

Print Preview Previews current print job.

Prefences Used to alter the appearance and to select options on the data
displayed on a node.  Also used to set a time delay so that slower
devices can respond to a Read Block Request.

Capture Comment Add comments to a specific capture saved to a file.

Self Test Used to test VK9000 internal hardware.

Exit Closes the application.

Item Description

Refresh Topology with Displays bus block information on the node on the Topology Map
Bus Info including GUID and node capabilities and protocols supported.

Refresh Topology with Self ID Displays Self ID information on the node on the Topology Map only
only including Node ID and speed.

Refresh Topology Normally Standard method for refreshing bus topology.

Refresh Topology with Time Used to set a time delay so that slower devices can respond to a
Delay Read Block Request.

Event Time in Ticks Displays time data in ticks in the Event List/Transaction Viewer.

Event Time in ns Displays time data in nano seconds in the Event List/Transaction
Viewer.

PHY Power Cable Off Turns off 1394 power  provided to the PHY.  Makes the VK9000 a
power consumer. Can cause topology recognition problems if this
mode is selected and a device is connected which does not provide
1394 power to the bus.
In this case turn off the unit.

PHY Power Cable On Turns on 1394 power provided to the 1394 bus, + 15 w.

2.6  VK9000 User Interface Tour
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View Menu
The View menu contains commands which impact the Topology Map and the Event

List/Transaction Viewer.  The View menu also contains commands for changing

display options and customizing interface menus and buttons.

View Menu

Item Description

Topology only Displays Topology Map completely in Topology window, Event List/
Transaction Viewer is not displayed.

Topology and Event List Displays Topology Map and Event List/Transaction Viewer in
Topology window.

Event List only Displays Event List/Transaction Viewer completely in Topology
window, Topology Map is not displayed.

Toolbar Used to select if the Toolbar is displayed.

Status Bar Used to select if the Status Bar is displayed.

Topology Live Displays Live (active) bus topology.

Topology Logged Displays topology saved to a file or contents of the capture buffer.

Topology Expanded View Displays full node display information including GUID, Node
Capabilities and Node ID number and Node Speed.

Topology Collapsed View Displays shortened node display information including Node ID and
Node Speed only.

Details Opens the Data Explorer window.

Total Data Captured Displays statistical information from the capture buffer.

Search for Event Opens the Search for Events window, which is used to search for
specific events in the Event List/Transaction Viewer.

Event List Fields Select fields displayed on the Event List.

Quick Filter Apply a quick filter to data in the capture buffer.

Display Options Used to configure how data is displayed and optional display
choices. Discussed as a separate topic in this manual.

Customize Opens the Customize window, which is used to change/select menu
commands and buttons that are displayed on the VK9000 interface.
Users can quickly customize commands and buttons used most.
Separate topic in this manual.

Isochronous Only Filters out all packets except Isochronous packets.

Async Only Filters out all packets except Asynchronous packets.

Remove Cycle Start Filters out of the capture buffer Cycle Start packets.

No Filter Turns off any applied filter settings.

2.6  VK9000 User Interface Tour
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Filter Menu
The Filter menu contains commands used to filter data when displayed in the Event

List/Transaction Viewer.

Filter Menu

Item Description

Summary Opens the Summary tab on the Filter window, which contains all filter
setting from the other three tabs (Source, Destination, and Transaction).

Source node ID Opens the Source tab on the Filter window, which contains filter settings
for Source ID.

Destination node ID Opens the Destination tab on the Filter window, which contains filter
settings for Destination ID.

Destination address Opens the Destination tab on the Filter window, which contains filter
settings for Destination ID.

Transaction code Opens the Transaction code tab on the Filter window, which contains
filter settings for Transaction codes.

Trigger Menu
The Trigger menu contains commands to start a new data capture and to display the

most current bus topology.

Trigger Menu

Item Description

New Capture Opens the Trigger window, which is used for all trigger customization/
settings.

Refresh Topology Refreshes displayed topology with most current/active bus topology.

Generator Menu
The Generator menu provides commands to begin generating 1394 packets and to stop

continuous Isochronous packet generation.

Generator Menu

Item Description

Data Generator Opens the Data Generator window, which is used to select packet
generation options.

Generator for Protocols Planned future enhancement.

Stop Iso Generation Stop Isochronous packet generation.
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Zoom Menu
The Zoom menu is used to minimize and maximize the appearance of the various 1394

nodes on the Topology Map.

Zoom Menu

Item Description

Zoom In Increases the size of nodes on the Topology Map.

Zoom Out Decrease the size of nodes on the Topology Map.

Tools Menu
The Tools menu contains a commands to start the Script Editor, which is used to set

up customized triggering and generation automated responses, the Soft Keyboard, and

the real-time Bandwidth Monitor.

Tools Menu

Item Description

Script Editor Open the Scripting Engine API, which is used to customize and automate
testing procedures.
Optional feature.

Soft Keyboard Digital keyboard, operated via the touchscreen for data entry.  Separate
topic in this manual.

Bandwidth Monitor Real time bandwidth monitoring of the 1394 bus.  Separate topic in this
manual.

Help Menu
The Help menu contain version information for the VK9000 software and access to the

VK9000 Online Help.

Item Description

Help Topics Opens the Online VK9000 User Guide.

About DPX Displays current VK9000 software build.

Soft Keyboard Window
Use the Soft Keyboard to enter data with a stylus without using the keyboard.  This

option is selected from the Tools menu. After the Soft Keyboard window opens, press

the appropriate buttons.  To end the Soft Keyboard user session, click the Soft

Keyboard command on the View menu.

Soft Keyboard

2.6  VK9000 User Interface Tour
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Real Time Bandwidth Monitor
The Real Time Bandwidth Monitor displays current bandwidth consumption on the

1394 serial bus.  Bandwidth is measured by selecting a Sampling Interval and then

selecting whether to measure Asynchronous bandwidth usage by clicking the Async

button, Isochronous bandwidth by clicking the Iso button, or total bandwidth by clicking

the Total button.  The Async, Iso, and Total vertical columns display in real time the

average consumed percentage of bandwidth and also continuously track high and low

bandwidth with horizontal marks.  These high and low marks carry over from previous

sampling cycles until replaced by new higher or lower values.

Bandwidth is also tracked via the sampling period in the right hand section of the

window.  This display also shows the average and high and low, but the high and low

numbers do not carry over from previous sampled cycles.  Instead each measure of

high, low, and average reflect the sample interval only.

Real-Time Bandwidth Monitor
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Customize Window
The Customize window selected from the View menu via the Customize command

contains four tabs used to alter the appearance of the interface.  The Commands tab is

used to create shortcut menu buttons.  Users select a menu item from the Categories

list. Then from the Commands section, select a command desired as a shortcut button

and drag it to the button toolbar.  The Command will appear as a shortcut button.

Commands Tab

The Toolbars tab contains options for selecting if the Menu and Button bars are

displayed.

Select the Menu Bar and/or Sandard bar and if need click the Reset All button.

Toolbars Tab

2.6  VK9000 User Interface Tour



2-20 IM 703425-01E

The Menu tab contains options to determine which menus are displayed.

Menu Tab

The Options tab is used select the size of the Button bar icons.

In the Toolbar and Personalized Menus and Toolbars sections of the Options tab

select the desired check boxes and click the Reset my usage data button.

Options Tab
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Display Options Window
The Data Details tab is used to select if packet details are displayed in the Data

Explorer or Classic Details window and to further select how data appears in sections

of the Data Explorer.

Data Details Tab

The Event List tab contains data display choices that focus on timing details displayed

in the Event List.

Event List Tab

The Topology tab on the Display Options window provides settings that affect the

Topology Map.  Use these settings to change the appearance of the Topology Map or

compensate for the operational idiosyncrasies of some devices.

The contents of the node’s bus information block are used to update Node

Identification boxes with the correct icon, node name, GUID, and node

capabilities.Normally, select or use the Refresh Topology with Bus Info.  In some

cases, however, you may wish to suppress the sending of these Read Quadlet

Requests. Then, select Refresh Topology with Self ID Only. The Node Identification

boxes then display only the Node ID and speed.

If no updated topology is desired or needed, select No Topology Refresh on Bus

Reset from the Topology tab on the Display Options window.  This feature is

particularly useful if your debugging situation creates bus reset storms or if you do not

want to refresh topology.

1394-1995 specifies that when a Read Quadlet Request is received by a device, it must

respond with a read quadlet response within a certain amount of time.  Otherwise the

transaction is considered incomplete.

When Refresh Topology Normally is specified, the VK9000 waits for the specified time

for each device to respond.  If a device does not respond, the requests are retried four

times.
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Some devices however, need more time to respond.  In this case, select Refresh

Topology with Time delay and enter in the Time field a value in milliseconds.

The Automatic Detection box contains update choices for port information and

protocols.  If these options are selected, after a bus reset the selected information, for

instance, port information, is updated.  For large captures, however, this option can slow

down data display time.

Topology Tab

The Warning Msg tab contains choices that impact whether warning messages are

displayed before a specific action.

Warning Msg Tab

The Protocols tab contains update choices for port information and protocols.  If these

options are selected, packets are automatically recognized in the Event List/

Transaction Viewer, for instance an Asynchronous packet could be recognized in the

Event List as an AV/C command.  For large captures, however, this option can slow

down data display time.

Protocols Tab Quick Tour
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2.7 Quick Tour Overview

To start the VK9000, press the power button located to the back of the unit.  The VK9000

starts. The VK9000 software uses a specially configured version of Windows NT. After

the VK9000 hardware (the computer) is turned on, the VK9000 software automatically

starts.   If you exit the VK9000 application and want to restart it, double-click the VK9000

icon on the desktop.

Quick Tour: Topology Window
The Topology Map, occupying the upper half of the VK9000’s screen just below the

toolbar, displays a map of the topology of the 1394 bus attached to the VK9000 including

the VK9000’s node.

Topology Map

• On the Trigger menu select the Refresh Topology command.

Tip

On the toolbar click the Refresh Topology button.
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2.7  Quick Tour Overview

Quick Tour: Event List
The Event List occupies the lower half of the VK9000’s main screen. It displays the

contents of the capture buffer.  User can select to view capture buffer contents in the

Event List or via the Transaction Viewer.

The Event List and Topology window can also display previously saved data.

Event List

Transaction Viewer

On the File menu select Open.

Tip

On the toolbar click the Open button, it is same as File-Open.

Navigate to the Data folder and double-click the 3iso_1asyn.fwx file.

The Event List displays packets from the saved file.  The Topology Map is updated to

reflect the topology of the bus at the time of the data capture. The background color of

the Topology window changes to reflect a Logged Topology instead of a Live Topology.

The Status bar at the bottom of the screen displays the current topology status:

Topology: Logged.
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Quick Tour: Filtering
Use the Filter feature to quickly sift through a large capture buffer and locate events of

interest.  This section of the Quick Tour uses data from a sample file to demonstrate not

only the Filter feature but the Data Explorer.  For example, the file, 3iso_1asyn.fwx,

contains several Write Quadlet Request packets interspersed with numerous Cycle Start

and Stream packets.  Rather than tediously scroll through the Event List searching for

Write Quadlet Request packets, use the Filter function to sift through the Event List and

display only the Write Quadlet Request packets.

Filter Window

1. On the File menu select Open.  The Open dialog box appears.

2. Select 3iso_1asyn.fwx and click OK.  Packet data fills the Event List.

3. On the Filter menu, select the Summary command.  The Filter window appears.

4. Select Transaction Code(s) check box.

5. Click the … button. The Transaction Code dialog box appears.

6. Click Write Quadlet Request.

7. Click OK.  The Event List now displays only Read Quadlet Request packets.

8. On the Filter window, clear the Transaction Code(s) check box and click OK to

disable filtering.

Tip

On the toolbar click the Filter button, it is same asa Filter-Summary.

2.7  Quick Tour Overview
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Quick Tour: Data Explorer
The VK9000 contains a very powerful Data Explorer used to analyze and decode

packets and search for packets based on contents.

From the File menu select Open and select 3iso_1asyn.fwx. Scroll through the Event

List until packet 51 appears. The second column of the Event List displays the event

number or index of each packet.Double-click Event 51.  The Data Explorer appears,

displaying the selected packet.

Once the Data Explorer is open, use it to examine any packet in the capture buffer.

Scroll through the Event List to find the appropriate packet and then click it to display

the packet in the Data Explorer.

Data Explorer Window

The Data Explorer contains several windows:

• The Raw Packet window appears in the right section of the Data Explorer. It displays

the 1394 packet in its raw hex form.

• The Packet Timing window appears in the lower right corner of the Data Explorer.  It

displays timing information about each packet.

• The Packet Format window appears in the center section of the Data Explorer

display.

• The Protocol Selection window appears in the left section of the Data Explorer

display. This window is used to specify the protocol used to decode the packet shown

in the Packet Format window.  Typically, the 1394-1995 protocol should be

highlighted.

You can save the packet appearing in the Data Explorer for later use when generating

packets. Click Save Packet at the bottom of the Data Explorer.

The Data Explorer contains a very powerful search tool. You can search for other

packets in the capture buffer containing the same or similar contents.  You can also

search for packets containing one or more identical header fields.

2.7  Quick Tour Overview
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Quick Tour: Setting a Trigger and Generating Data
This section of the Quick tour involves using the Data Generator to first generate data

and then in the second section, to generate, capture, and display packet data.  The Data

Generator is one of the most powerful features of the VK9000. Simultaneously generate

and capture Asynchronous, Isochronous, and PHY packets.  While viewing a packet with

the Data Explorer, you can save it.  Subsequently, in the Data Generator window you

can recall the saved packet, modify it if necessary, and send it.  You can build entire

sequences of packets for sending and save the sequences for later re-use.  The Data

Generator also provides support for resending sequences of Isochronous packets

currently in the capture buffer and sending packets with bad CRC values, invalid fields,

etc.

Data Generator Window

The Data Generator window provides an easy and flexible environment for building and

sending 1394 packets.  To display the Data Generator window, select Data Generator

from the Generator menu.

Before accessing the Data Generator window on the View menu select Soft Keyboard

then on the toolbar menu click the Data Generator button.    The Soft Keyboard

appears.

Tip

On the toolbar click the Start Generation button, it is same as Generator-Data

Generator.

Soft Keyboard

The tabs on the Data Generator window provide controls to build the various types of

packets.   For instance, the Asynchronous tab provides the controls for building and

sending Asynchronous packets.  Similarly, the remaining three tabs provide controls for

building Isochronous, and PHY packets.

2.7  Quick Tour Overview
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2.7  Quick Tour Overview

You can also simultaneously send and capture packets with the Send/Capture button.

This allows you to not only send packets but to view the responses.

To demonstrate this feature, complete the following steps which involve reading a node’s

GUID from its Bus Info Block.  Each node stores its GUID in a pair of quadlets starting

at F0000408.  (There are simpler ways to obtain a node’s GUID, but this procedure

overviews several key processes such as using the Data Generator and setting a

trigger.)

Setting Up the Data Generator

Prerequisite: a 1394 device.

1. Connect the 1394 device to the 1394 port on the VK9000.

2. On the Topology Map, locate any node other than the VK9000’s node, and note

the Node ID.

3. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

4. From the Packet Type list select Rd Blk Req.  From the Speed list select 100.

(You may be able to use a higher speed, depending upon the path to the desired

node.)

5. On the Header box, enter in the second section of the Dest ID field the ID of the

node from Step 1.  In the Dest Offset Low field enter F0000408.  In the Data

Length field enter 8.

Setting the Trigger

1. Click the Setup Trigger button.  The Trigger window appears.

2. On the General tab, on the Capture Options box, clear Force Bus Reset, Log

Cycle Start, and Log ISO Packets check boxes.  On the Basic Triggers box

select the Async check box.  Clear the Payload and Error check boxes if

selected. In the After Trigger field enter any number larger than ten like 100.

3. On the Trigger window click the Asynchronous tab. Check the Source ID check

box and enter the Node ID of the 1394 device connected to the VK9000. Next to

the Transaction Code field click the … button.  The Transaction Code dialog box

appears.

4. Select Read Block Response and click OK.  The Transaction Code dialog box

closes.  On the Trigger window, click OK. The Trigger window closes and the

Data Generator window appears.

Trigger Window
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2.7  Quick Tour Overview

Using the Data Generator

1. On the Operation box of the Data Generator window, click the Send/Capture

button.  Data generation and data capture begins.

2. Click the Stop button.  The Event List appears and contains at least two packets.

The highlighted packet is the response to the Read Block Request.

3. Double-click the packet.  The Data Explorer appears.

4. On the Payload box click the Hex radio button.  The center window of the Data

Explorer displays 8 bytes, the node’s GUID.  Verify the accuracy, by comparing

this value to the node’s GUID on the Topology Map.
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3.1 Topology Map Overview

The Topology Map, which appears in the Topology window, provides a high-level view

of the actual network topology.  It displays all of the nodes connected to a single 1394

bus up to the maximum of 63 nodes.

Each time a bus reset is detected the Topology Map updates automatically (when a live

topology is displayed). Topology is also updated when a node is attached or detached

from the bus during a capture.  See Live vs. Logged Topology section for more

information.

To manually refresh the Topology Window

• On the toolbar click the Refresh Topology button.

Note
Clicking the Refresh Topology button causes a bus reset.

Altering the Appearance of the Topology Map
Topology Map Appearance

Several commands and shortcut buttons are available to adjust the appearance of the

Topology Map including:

• Adjusting the relative sizes of the Topology Map and Event List

• Hiding the Event List/Transaction Viewer to display an enlarged Topology Map

• Restoring the split screen view

• Increasing and decreasing the size of the Topology Map

• Increasing and decreasing the size of Topology nodes

To adjust the relative sizes of the Topology window and Event List

• Drag the horizontal bar dividing the Topology Map and the Event List/Transaction

View up or down.

To hide the Event List and fill the entire area with the Topology window

• On the View menu select the Topology Only command.

Tip

On the toolbar click the View Topology button, it is same as View-Topology Only.

Chapter 3 Topology Window
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To restore the Event List/Topology window split screen

• On the View menu select the Topology and Event List command.

Tip

On the toolbar click the Topology and Event List button, it is same as View-

Topology and Even List.

To zoom the Topology Map in or out

• On the Zoom menu select the Zoom In or Zoom Out commands.

Tip

On the toolbar click the Zoom buttons, they are same as Zoom In/Out.

Live vs. Logged Topology
The Topology Map displays either live or logged topology. Live topology reflects the

topology of the 1394 device(s) and the VK9000 node.  Logged topology is captured data.

The status of the topology displayed in the Topology Map is indicated by:

• The Status bar at the bottom of the screen which always displays either Topology:

Live or Topology: Logged

• The background color of the Topology window which is different for live (red) vs.

logged (green) topology

In some cases, it is helpful to be able to quickly switch between live and logged topology

in order to compare them.

To view topology saved to a file, on the File menu select the Open command.

Tip

On the toolbar click the Open button.

To switch between Live and Logged Topologies

• On the View menu select either the Topology Live or Topology Logged commands.

WARNING

The Network Topology can look different after each bus reset.

3.1  Topology Map Overview
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Topology Display Options
The Topology tab on the Display Options window provides settings that affect the

Topology Map.  Use these settings to change the appearance of the Topology Map or

compensate for the operational idiosyncrasies of some devices.

Settings in the Topology tab are saved for the next user session.

Refresh Topology with Bus Info vs. Refresh Topology with SelfID Only

The contents of the node’s bus information block are used to update Node

Identification boxes with the correct icon, node name, GUID, and node capabilities.

Normally, select or use the Refresh Topology with Bus Info.  In some cases, however,

you may wish to suppress the sending of these Read Quadlet Requests. Then, select

Refresh Topology with SelfID Only. The Node Identification boxes then display only

the Node ID and speed.

No Topology on Bus Reset

If no updated topology is desired or needed, select No Topology Refresh on Bus

Reset from the Topology tab on the Display Options window.  This feature is

particularly useful if your debugging situation creates bus reset storms or if you do not

want to refresh topology.

Refresh Topology with Time delay

1394-1995 specifies that when a Read Quadlet Request is received by a device, it must

respond with a read quadlet response within a certain amount of time.  Otherwise the

transaction is considered incomplete.

When Refresh Topology Normally is specified, the VK9000 waits for the specified time

for each device to respond.  If a device does not respond, the requests are retried four

times.

Some devices however, need more time to respond.  In this case, select Refresh

Topology with Time delay and enter in the Time field a value in milliseconds.

Automatic Detection Box

The Automatic Detection box provides a way to update node information on the topology

map.  Use this option selectively with large data captures since this can slow down data

display.

Item Description

Port Information check box Select to automatically update port status information.

Protocols check box Select to automatically update protocol detection status for SBP-2
Management Agent, IP NPM, and AV/C.   Information is displayed
on the device’s node on the Topology Map.  If this option is
selected, after a bus reset, the VK9000 node will send read quadlet
requests to read Config ROM data.  For full functionality, devices
must contain a Unit Spec ID and a Unit Software Version for
protocol detection.  See the appendix for a full table of protocol
combinations and values supported.

3.1  Topology Map Overview
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3.1  Topology Map Overview

Self ID Box

On the Topology tab on the Display Options window click the Self ID Box button to

open the Self ID Box Configurator window.  Use this feature to select the most

appropriate information to be displayed on the Self ID section for nodes on the bus. Use

the left and right arrows to move options to and from Display box.  If needed click the

Load Defaults button to reset the VK9000’s factory default settings.  When finished click

OK to make selected changes or click Cancel to close the window without making

changes.

Self ID Box Configuration Window

PHY Power Cable Off/on

The displayed can also change depending on whether the PHY Power Cable Off or PHY

Power Cable On from the File menu is selected.

Item Description

PHY Power Cable Off Turns off 1394 power provided to the PHY.  Makes the VK9000 a power
consumer. Can cause topology recognition problems if this mode is
selected and a device is connected which does not provide 1394 power
to the bus.
In this case turn off the unit.

PHY Power Cable On Turns on 1394 power provided to the 1394 bus, + 15 w.
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3.2 Understanding Topology Map Nodes

Node Identification
The Topology Map displays node information for each node on the 1394 bus in a Node

Identification box.

A node is divided into two sections.  The section to the left contains the Node ID and the

Node Speed and also displays PHY port status.  The section to the right contains the

Node GUID, Node Capabilities, and Protocol capabilities along with a node icon.  The

VK9000, however, displays a Question Mark or Generic icon for 1394 devices connected

for the first time.  If desired, you can also add your own icons or change icons.

Node ID boxes either display full Node ID information or abbreviated Node information.

Users determine if both sections of the Node box are necessary.  If the gray arrow is

clicked the right hand section of the node disappears.  Click the gray arrow to expand the

box.

Topology Map

The node’s capabilities are depicted using one or more of the following acronyms:

Item Description

isc Isochronous capable.

cmc Cycle Master capable.

irmc Isochronous Resource Manager capable.

bmc Bus Manager capable.

Each acronym may be displayed in upper or lower case.  Lower case indicates that the

node is capable of serving in the master or manager role but is not currently acting in

that role.  Upper case indicates that the node is capable of serving in the master or

manager role and is currently acting in that role. For example, a node represented by

bmc is Bus Manager-capable, but is not the current Bus Manager; BMC would indicate

that node was acting as the current Bus Manager.

When a node is connected to the bus for the very first time and no icon and Node

description has been defined, the Generic Node icon will be displayed.

If no information other than the Node ID and PHY Speed is displayed in the right-hand

side of the Node Identification Box, no access to the nodes bus_info_block (Link Layer

not active, CSR not implemented, etc.) is possible.

Speed Mapping
The transaction speed between two nodes is indicated on the line connecting two Node

Identification boxes.  The speed is determined by the slower of the two node PHY

Speeds.
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3.2  Understanding Topology Map Nodes

Using the Node Info Window
Overview of the Node Info Window

Use the Node Info window to analyze and change node and PHY properties.  The Node

Info window has four tabs: Self ID, CSR, Port, and Node.  The Node tab displays bus

information and contains controls for node operations.  The Self ID tab displays PHY

register information.  The CSR tab is used to send Read, Write, and Lock commands.

The Port tab displays port status and contains controls to change PHY port operations.

To change node capabilities

1. On the Topology Map double-click the left section of the Node ID box.  The Node

Info window appears.

2. On the Node Info window click the Node tab.

3. On the Operation box on the Node tab select the appropriate property.  Choices

include: Cycle Master, Iso Resource Mgr, Bus Manager, and Force Root.

4. Option: on the Operation box clear the appropriate property.

5. Click the Apply button.

To view node register data

1. On the Topology Map double-click the left section of the Node ID box.  The Node

Info window appears.

2. On the Node Info window click the Self ID tab.

To update port status

1. On the Topology Map double-click the left section of the Node ID box.  The Node

Info window appears.

2. On the Node Info window click the Port tab.

3. On the Port Status box on the Port tab click the Update button.

Node Info Window: Self ID Tab Controls
Use Self ID tab to view the Self ID packet of a node.

Node Info Window Self ID Tab

Item Description

Self ID Register Display Displays register information.

Prev Click to view a previously viewed section of the register. Note: The Prev
button only applies  to a node sending more than one Self ID packet, for
instance a six-port PHY.

Next Click to view the next section of the register. Note: The Next button only
applies to a node sending more than one Self ID packet, for instance a
six-port PHY.



3-7IM 703425-01E

3

T
o

p
o

lo
g

y W
in

d
o

w

Node Info Window: CSR Tab Controls

Node Info Window CSR Tab

Item Description

Read Select to send a Read command.

Write Select to send a Write command.

Lock Select to send a Lock command.

Address Offset (Hex) Select the needed Offset to send the command.

Extended tcode Select an Extended transaction code.

Delay by Enter a delay, value in milli seconds.

CSR Value Displays the CSR value derived from the action.

Apply Select to complete the CSR command.

Advance Select the Advance option for more specific individual choices for Read,
Write, and Lock commands.

To perform a CSR Read, Write, or Lock Command

1. Double-click the left-hand portion of a Node ID box of a node on the Topology

Map.  The Node Info window appears.

2. Click the CSR tab and select either Read, Write, or Lock.  Make other selections

as needed.

3. Click Apply.  CSR data appears in the CSR Value box.

3.2  Understanding Topology Map Nodes
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3.2  Understanding Topology Map Nodes

CSR Read
Use the CSR Read window to access a node’s CSR registers.

Node Info Window CSR Read Tab 

Item Description

Packet Type Select to send a Read Quadlet or a Read Block command.

Address Offset (Hex) Select the register location to send the CSR Read command.
Length Select a data length.

Delay by Enter a delay.

Address Hex Value and Display the CSR value.
ASCII

Read Executes the CSR Read command.

To access and read a node’s CSRs via the CSR Read window

1. Double-click the left-hand section of a node on the Topology Map and select CSR

Read from the Node Info window.  The CSR Read window appears.

Note
By default, the Data Analyzer uses Read Block Request commands to access a node’s

CSRs.  Some nodes do not support the Read Block Request Command and will result in a

CSR Read Error message. In this case, click the Read Quadlet radio button to switch to the

use of Read Quadlet Request commands to read CSRs.

2. From the Address Offset (Hex) list, select an appropriate register to read or enter

the address in hexadecimal in the field.

3. Option: if necessary, from the Length list select a new value.  By default, the value

is automatically set to the correct length. If Read Quadlet is selected as the

transaction type, the number of Read Quadlet Requests sent is Length*2)/8.

4. Option: if necessary, enter in the Delay By field a value.  Some devices cannot

respond to multiple Read Quadlet Requests unless there is some idle time

between them. If Read Quadlet Requests are used to access CSRs, then this

value specifies the time between Read Quadlet Requests. (This field is ignored if

Read Block Requests are used.)

5. Click the Read button.  The results are displayed in the lower window.

Response Codes are displayed separately for any address being read from.  Available

codes are Complete, Conflict Error, Data Error, Type Error, and Address Error.
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3.2  Understanding Topology Map Nodes

CSR Write
The CSR Write function uses Write Quadlet Request commands to modify a node’s

CSRs.

Node Info Window CSR Write Tab

Item Definition

Packet Type Select to send a Write Quadlet or a Write Block command.

Address Offset (Hex) Select the register location to send the CSR Read command.

Length Select a data length.

Write Data: (Hex) Enter in hexadecimal the value to write to the register.

Ack from the Node Displays the acknowledgement response from the node.

To write to a node’s CSRs

1. Double-click the left-hand section of a node on the Topology Map and select CSR

Read from the Node Info window.  The CSR Read window appears.

2. From the Address Offset (Hex) list, select the register to write to.  You can also

enter the address in hexadecimal in the field.

3. Specify the number of bytes to be written in the Length field.

4. Specify the CSR’s new contents in the Write Data: (Hex) field.  The contents must

be specified in hexadecimal.

5. Click the Send button. The Ack from the Node field indicates the results of the

operation.
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CSR Lock
A lock transaction passes an address, subcommand, and data parameter(s) from the

requester to the responder and returns a data value from the responder to the requester.

Node Info Window CSR Lock Tab

Item Definition

Address Offset (Hex) Select the register location to send the CSR Read
command.

Length Select a data length.

Extended Tcode Select an extended transaction code.

Argument and Data Values (Hex) Enter in hexadecimal up to four quadlets to send.

Response Code Displays the response code from the node.

To write to a node’s CSRs using Lock commands

1. Double-click the left-hand section of a node on the Topology Map and select CSR

Read from the Node Info window.  The CSR Read window appears.

2. From the Address Offset (Hex) list, select the register to read.  You can also enter

the address in hexadecimal in the field.

3. Specify the number of bytes to be written in the Length field.

4. Specify the extended transaction code in the Extended Tcode field.

5. Specify up to four quadlets to be written in the four Argument and Data Values

fields. The contents must be specified in hexadecimal.

6. Click the Lock button.

Response Codes are displayed separately for any address.   Available codes are

Complete, Conflict Error, Data Error, Type Error, and Address Error.

3.2  Understanding Topology Map Nodes
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Node Info Window: Port Tab Controls
Use the Port Status box to change the selected PHY port functions or update port

functions.

Node Info Window Ports Tab

Item Definition

Port Status Displays PHY port status.

Update Click to update PHY port status.  Information is then displayed in
the Port Status box.

Port Operation box Port list Select a port to change an operation characteristic.

Apply Click to apply selected port operation characteristics.

Disable Click to disable a PHY port (cannot transmit, receive, or repeat
serial bus signals).

Suspend Click to suspend a PHY port (connected but not operational).

Clear fault bit Click to clear preset fault bit.

Enable Click to activate the PHY port.

Resume Click resume the PHY port (completed before becoming active).

Resume All Click to resume connected PHY ports.

3.2  Understanding Topology Map Nodes
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Node Info Window: Node Tab Controls
Use the Node tab to view node information and to set node properties.

Node Info Window Nodes Tab

Bus Info Block box

Item Definition

Node ID Displays the number assigned to a node on the bus.

GUID Displays the globally unique identifier of a device.

Cycle Master Displays if a node is Cycle Master capable.  The field is blank if
the node is not capable of the function.

Iso Displays if a node is capable of Isochronous packet generation.
The field is blank if the node is not capable of the function.

IRM Displays if a node is Isochronous Resource Manager capable.
The field is blank if the node is not capable of the function.

Bus Manager Displays if a node is Bus Manager capable.  The field is blank if
the node is not capable of the function.

Response Option box

Item Definition

Type list Select a packet type for an auto response.  Then check the
Auto Response check box and click OK.

Auto Response on check box Select to set the auto response packet type.

Disable Asynch Receive check Select to disable the sending of Ack packets when a Async
box request is received.

Operation box

Item Definition

Cycle Master Set the node as Cycle Master.

Iso Resource Mgr Set the node as Isochronous Resource Manager.

Bus Manager Set the node as the Bus Manager.

Force Root Set the node as the root.

Apply Click to apply selected settings.

3.2  Understanding Topology Map Nodes
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3.3 Event List and Transaction Viewer Overview

The Event List displays packets captured in the buffer. The Event List provides a high-

level overview or summary of each packet.  From the Event List, you can launch the

Data Explorer or Classic Details window to examine any packet in greater detail.

Event List Window

Transaction Viewer Window

Packets in the Event List are displayed chronologically. The oldest packet is at the top

of the Event List, and the newest packet is at the bottom of the Event List.

Several controls are available to adjust the appearance of the Event List window.

The Transaction Viewer window provides a graphical representation of activity on the

1394 bus.  It is divided into three major sections: Initiator, Cable, and Target.  Initiator

and Target are further subdivided into PHY Layer and Link Layer sections.  The PHY

Layer or Link Layer for the Initiator and Target contain 1394 packets reflecting bus

activity.

Tip

On the View menu select the Display Options window Protocol tab to customize the

various protocol display options.  Selecting one of the options enables protocol

recognition in the Event List and Transaction Viewer—quick way to immediately

recognize protocols contained in a 1394 packet. Settings on the Protocol tab are saved

for the next user session.

To view packet data in the Transaction Viewer

• Select the Transaction tab. Data is displayed in the Transaction Viewer—requires

live or logged data.

To view packet data in the Event List

• Select the Event List tab.  Data is displayed in the Event List—requires live or

logged data.
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To adjust the relative sizes of the Event List and Topology window

• Drag the horizontal bar dividing the Topology Map and the Event List up or down.

To hide the Topology Map and fill the entire area with the Event List

• Select the Event List Only command from the View menu.

To restore the Event List / Topology window split screen

• Select the Topology and Event List command from the View menu.

To change the width of a column in the Event List

• Drag the boundary on the right side of the column heading until the column is the

appropriate width.

To display timestamps in ns

1. On the View menu select Display Options.  The Display Options dialog box

appears.

2. Select the Event List tab and select Display in milli sec.microsec.nanosec.

To display timestamps in Ticks

1. On the View menu select Display Options.  The Display Options dialog box

appears.

2. Select the Event List tab and select Display in sec.cycle.tick.

To hide all Acknowledge packets

1. On the View menu select Display Options.  The Display Options dialog box

appears.

2. Select the Event List tab and select Hide All ACK packets.

3. Capture data as needed

4. On the File menu select Save.

Note
Data must be saved to a file to remove Ack packets from the capture buffer display.

Enabling Protocol Recognition in the Event List
The VK9000 supports protocol recognition in the Event List. For instance, when this

feature is enabled users can quickly scan packets in the Event List a select the higher

level protocol from the Event List and then double-click the packet to examine it in

greater detail in the Data Explorer.  Protocol recognition can, in the case of large data

captures slow, data display in the Event List.  For optimal performance, users should

select which protocol(s) to recognize, if any, in the Event List.

To enable protocol recognition in the Event List

1. On the View menu select Display Options.  The Display Options window

appears.

2. On the Display Options window click the Protocols tab and select Enable

Protocol Display in Event List.  As needed, select other settings including AV/C,

IPv4, SBP2, IEC 61883, HAVi, and CP1 (CP2).

3. Click OK.

3.3  Event List and Transaction Viewer Overview
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3.4 Using the Event List

Event List Fields
The following section describes the fields in the Event List.  Not all fields are present in

each packet. For information about 1394 packet types and the fields contained in each,

refer to the packet description section in the 1394-1995 specifications and related

updates.

Item Definition

Type Indicates whether the packet is an Asynchronous, Stream, or PHY packet.  If
protocol recognition is enabled (Display Options window, Topology tab), the specific
protocol contained in the 1394 packet is recognized

Index A sequential number.  The first packet is assigned the numerical value of one.
When the packet is displayed in the Data Explorer, the packet’s index appears in
the Data Explorer’s title bar.

Time Timestamp taken at the end of the packet.
When the network has a Cycle Master, the timer is set to zero as the first Cycle
Start packet is captured. If there is no Cycle Master, the counter is reset by the
VK9000’s internal clock. The timestamp is of the form AAA.BBBB.CCCC.
AAA A seconds counter.
BBBB Cycle starts. The time segment between two cycle start packets is 125 ms.

When this counter value reaches a maximum of 8000, it rolls over and the
seconds counter is then increased by one.

CCCC Number of ticks (40.7 ns). This is the time period generated by the onboard
oscillator. When this counter value reaches a maximum of 3092, it rolls over
and the cycle start counter is then increased by one.

Tcode Transaction Code. The transaction code is decoded and displayed in English.

ExTcode Extended Transaction Code. This code is only relevant when the transaction code
indicates a Lock Request or Lock Response packet type.  The extended transaction
code is decoded and displayed in English.

SrcID Source ID. Specifies the Node ID of the sending node.

DestID Destination ID. Specifies the Node ID of the receiving node.  This is only available
for Asynchronous packets.  A Destination ID with the value 63 indicates that the
Asynchronous packet is being broadcast, that is, no single specific destination node

DstAddr Stream and Cycle Start packets are always broadcast.
Destination Address Low. Specifies the lower 48 bits of the destination node
address for a request packet.

Tlabel The Transaction Label specifies a unique tag for each outstanding transaction from
a node.  The Transaction Label sent in a request subaction is then used as the
Transaction Label returned in the corresponding response subaction.

Retry Retry Code. Indicates whether this packet is a retry attempt and then defines the
retry protocol to be followed by the destination node.  The Retry Code is decoded
and displayed in English.

Resp Response Code. Specifies the response to an earlier corresponding request
subaction.  The response code is decoded and displayed in English.

Priority A priority level of 0 (0000) ≥ corresponds to the fair arbitration mechanism and 15
(1111) ≥ to the highest priority with fairness disabled.

Speed Specifies the data rate used to transmit the packet.

Channel Specifies the Isochronous channel number for the packet assigned by the
Isochronous Resource Manager.  The available channel numbers are 0 through 63.

Tag Specifies the data format carried by an Isochronous packet:
00 Data field unformatted
01 Reserved
10 Reserved
11 Reserved

Sync Synchronization Code. Specifies an application specific control field.
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Item Definition

Ack Acknowledgement. Displays the content of the acknowledge packet that is sent as
the immediate response to a non-broadcast or to a non-Isochronous packet.  The
Ack code is decoded and displayed in English.
Note: When 00? appears in this field, it means that no acknowledgment was

received or that the acknowledgement contained an illegal Ack code of
00.

Data Length Displays the length of the data field of block payload packets and Isochronous data-
block packets.  The length is expressed as a decimal value.

Viewing Packet details
From the Event List or Transaction Viewer, you can view packet contents in detail in

the Data Explorer.

To view packet details

• Double-click the desired packet in the Event List.

Searching for Packets
Use the Search tool to search the Event List for packets with specific characteristics.

Use the Search tool for quick simple searches.  For more complex searches, use the

search features in the Data Explorer.

To search for packets in the Event List

1. On the View menu click the Search for Event command.  The Dialog for

Searching Event dialog box appears.

2. Select a category to search and if necessary, enter search criteria.  Some

categories, such as Tcode, require a specific value to be entered.  For example,

selecting Tcode and selecting Iso in the associated list will cause the VK9000 to

search the Event List for an Isochronous packet.  The first Isochronous packet

found is then highlighted.  Press F3 to find the next matching packet.

3. Option: Select the Invert Value check box to perform a NOT search.  For example,

selecting Tcode, Iso, and Invert Value will result in finding the first packet that is not

an Isochronous packet.

4. Click OK.

Tip

Click the Search toolbar button icon to display the Dialog for Searching Event dialog

box.

3.4  Using the Event List



3-17IM 703425-01E

3

T
o

p
o

lo
g

y W
in

d
o

w

Filtering the Event List
Filter Packets

Use the Packet Filter to hide packets in the Event List.  For example, if you are

interested in viewing only Asynchronous packets but the Event List also contains many

Isochronous and PHY packets, you can use the Packet Filter to display only

Asynchronous packets.

Filter Window

To filter packets in the Event List

• On the Filter menu click the Summary command.

The Summary tab displays all the available filter settings.  You can, however, limit

filter settings by using any of the other three tabs.  For example, click on the Source

tab to limit the display to only the Source Node ID(s) setting.  All six of these settings

can be combined.  For example, to specify that you want to see only Read Quadlet

Requests sent from Node 2 to Node 3, Specify 2 as the Source ID, 3 as the

Destination ID, and Read Quadlet Request (4) as the Transaction Code.

Tip

On the toolbar menu click the Filter button.

Filter Window Settings

Use the Filter window setting to customize data filtering.

Item Definition

Source Node ID(s) Displays only packets in the Event List containing the specified
Source IDs.  If multiple IDs are entered, separate with commas.

Destination Node ID(s) Displays only packets in the Event List containing the specified
Destination IDs.  If multiple IDs are entered, separate with commas.

Destination Address Low Displays only packets in the Event List containing the specified
value in the destination Address Low field.  The value entered
must be in hexadecimal.

Transaction Code(s) Displays only packets in the Event List containing the specified
transaction codes.  Use the … button to select from a list of
transaction codes.

Extended Transaction Code(s) Displays only packets in the Event List containing the specified
extended transaction codes.  If codes are entered, separate
them with commas.

Data Length(s) Displays only packets in the Event List containing the specified
data Length values.  If multiple values are entered, separate
them with commas.  Data Length values must be entered in
hexadecimal.

Save Setting Use this button to save the displayed combination of filter
settings for later re-use.

Load Setting Use to load a filter setting saved as a file.

Add Quick Filter Add the filter setting to the Quick Filter pop-up menu. You must
also save the settings to a file using the Save Setting button.

3.4  Using the Event List
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Saving Filter Settings

If needed, save Filter conditions for future.  On the Summary tab click the Save Setting

button.  In the Save As dialog box assign a name, and click Save.

Load trigger settings by selecting a special file from the combo box.  All files stored in the

settings-directory will be displayed.  Or use the Browse button to select from any other

directory.

Saving, Loading, and Exporting Data Displayed in the Event List / Transaction Viewer
Use the Save command to save to a file data from the Event List and the Topology

Map.

Use the Open command to display Event List / Transaction Viewer and Topology

Map data saved to a file.

Use the Save Event List as (CSV) command to export Event List data in a comma

separated value format (text).  Use the Save Topology as (BMP) to save to a bitmap

format file the Topology Map.

To save to a file

• On the File menu select Save.

To load a file

• On the File menu select Open.

To save Event List data in a csv. file format

• On the File menu select Save Event List as (CSV).

To save Topology Map data in a bmp. file format

• On the File menu select Save Topology as (BMP).

3.4  Using the Event List
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3.5 Bandwidth Tab Overview

Bandwidth analysis is provided via four tab options which provide graphical and tabular

information about bus performance including:

• Bandwidth utilization

• Histogram of Isochronous packet arrival times

• Isochronous channel utilization

The four tab sections for displaying bandwidth information: Bandwidth, Transmit Time,

Event Time Distribution, and Statistics.

Accessing Bandwidth Data
To analyze Bandwidth, Transmit Time, Event Time Distribution, and Statistics for

the entire contents of the Event List / Transaction Viewer

1. On the Event List / Transaction Viewer window click any event—need to click

only one event located anywhere in the Event List / Transaction Viewer.

2. Click Bandwidth, Transmit Time, Event Time Distribution, or Statistics tab.

Data for the entire contents appears in the selected window.

To analyze Bandwidth, Transmit Time, Event Time Distribution, and Statistics for a

selected range of packets in the Event List / Transaction Viewer

1. On the Event List / Transaction Viewer window click the first event in the desired

range.

2. Press the SHIFT key and click the last event in the desired range.  The desired

range is selected.

3. Click Bandwidth, Transmit Time, Event Time Distribution, or Statistics tab.

Data appears in the selected window.

To display a packet from the Bandwidth Chart in the Data Explorer

• On the Bandwidth Chart tab double-click a packet to display the packet in the Data

Explorer window. For more information about the Data Explorer, refer to the Data

Explorer section.
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3.5  Bandwidth Tab Overview

Bandwidth Tab

Bandwidth Chart Tab

Each 125ms cycle is oriented vertically, with the start of the cycle at the bottom and the

end of the cycle at the top.  Each Cycle Start packet appears as a small square at the

beginning (bottom) of each cycle.  Successive cycles appear left-to-right, with a total of

100 cycles displayed.

Vertical bars within each cycle denote packets being transmitted, with color-coding used

to differentiate packets. Isochronous packets are differentiated by a channel number.

Asynchronous packets are differentiated by Destination ID. Broadcast Cycle Starts are

labeled DestID63. The key to the color-coding appears in the upper right corner of the

chart.

Transmit Time Tab
The Transmit Time tab displays the utilization of Isochronous channels.  The unit of

measure is milliseconds (ms).

Transaction Time Tab
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Event Time Distribution Tab
The Event Time Distribution tab shows the packet arrival time distribution for each

Isochronous channel.  The histogram displays Isochronous packet arrival times for all

cycles within the selected range. The time measurement is taken at the start of the

packet.

By default, the X-axis displays the entire 125ms cycle. The Event Time Chart displays

only Isochronous data.  Asynchronous and PHY traffic is not displayed.

Event Time Distribution Tab

3.5  Bandwidth Tab Overview
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3.5  Bandwidth Tab Overview

Statistics Tab
The Statistics tab displays the same data displayed in the other related tabs, but in

tabular format instead of a graphical/visual format.

Statistics Tab
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3.6 Real-Time Bandwidth Monitor Overview

The Real Time Bandwidth Monitor displays current bandwidth consumption on the

1394 serial bus.  Bandwidth is measured by selecting a Sampling Interval and then

selecting whether to measure Asynchronous bandwidth usage by clicking the Async

check box, Isochronous bandwidth by clicking the Iso check box, or total bandwidth by

clicking the Total check box.  The Async, Iso, and Total vertical columns display in real

time the average consumed percentage of bandwidth and also continuously track high

and low bandwidth with horizontal marks.  These high and low marks carry over from

previous sampling cycles until replaced by new higher or lower values.

Bandwidth is also tracked via the sampling period in the right hand section of the

window.  This display also shows the average and high and low, but the high and low

numbers do not carry over from previous sampled cycles.  Instead each measure of

high, low, and average reflect the sample interval only.

Real-Time Bandwidth Monitor
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4.1 Capturing Packets Overview

Take advantage of the VK9000’s advanced triggering and data capturing abilities to

create specific trigger scenarios for capturing 1394 traffic.  Create and test a triggering

scenario and save it to a file for later use.  Like triggering scenarios, save to a file

packets captured in the online buffer for later use.  The VK9000, while offering triggering

from software, also provides a BNC Connector for external hardware triggering.

The VK9000 utilizes two capture buffer settings:

• Buffer Fill Mode

• Rotational Buffer Mode

Buffer Fill Mode
In Buffer Fill Mode, the buffer begins filling with 1394 packets when the Start button is

clicked.  If no trigger condition is specified, or if the trigger condition is not met, the

VK9000 stops capturing packets when one of the following events occurs:

• When the capture buffer is full

• When the Stop button on the Gathering Data window is clicked

If the trigger condition is met, the VK9000 will stop capturing packets when one of the

following events occurs:

• When your VK9000 has captured the number of packets specified by the After

Trigger field

• When the capture buffer is full

• When the Stop button on the Gathering Data window is clicked

Rotational Buffer Mode
Use the Rotational Buffer Mode when attempting to trigger on an infrequent event. In

this mode, the buffer begins filling with 1394 packets when the Start button is clicked

and is filled in two phases:

Phase One

Packets are captured and fill the capture buffer until the number of packets equals the

value specified in the Before Trigger field.  Data capture continues, but the number of

packets in the capture buffer remains constant, with the oldest packet discarded to make

room for the newest packet (in FIFO fashion).  This process continues until the trigger

condition is met.  At any time during this phase, if the trigger condition is met, the

VK9000 switches to Phase Two.  You can also stop the capture at any point by clicking

the Stop button in the Gathering data window.

Phase Two

After the trigger condition is met, the VK9000 continues to capture packets, capturing the

number of packets specified in the After Trigger field.

If the capacity of the capture buffer is less than the sum of the values specified in the

Before Trigger and After Trigger fields, the oldest packets are overwritten.

Note
In Rotational Buffer Mode it is possible to capture packets indefinitely until a trigger condition

is met; however, earlier captured packets are continuously overwritten.

Chapter 4 Capturing Packets
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4.2 Capturing Packet Scenarios

To capture 1394 bus traffic

1. On the Trigger menu select New Capture.  The Trigger window appear.

2. On the Trigger window select appropriate settings from the various tabs.

3. Click the Start button. The Gathering Data dialog box appears and displays the

status of the capture. The progress bar in the Gathering Data dialog box indicates

what percentage of the buffer has been filled.  The Events field indicates the

number of packets detected.

4. The Stop button to stop capturing bus traffic or wait until the capture buffer is full.

The Capturing Data dialog box closes and after a few moments the captured

packets are displayed in the Event List.

To capture all 1394 bus traffic

1. On the Trigger menu select New Capture.  The Trigger window appear.

2. On the General tab select the Log Cycle Start and Log Iso Packets check boxes.

3. On the General tab select the Buffer Fill radio button.

4. If desired, limit the size of the capture buffer by specifying a maximum packet count

in the Stop After field.

5. Click the Start button.  The Gathering Data dialog box appears and displays the

status of the capture. The progress bar in the Gathering Data dialog box indicates

what percentage of the buffer has been filled.  The Events field indicates the

number of packets detected.

6. Click the Stop button to stop capturing bus traffic or wait until the capture buffer is

full. The Capturing data dialog box closes and after a few moments the captured

packets are displayed in the Event List / Transaction Viewer.

To ignore all Isochronous packets

1. On the Trigger menu select New Capture.  The Trigger window appear.

2. On the General tab clear the Log ISO Packets check box.

3. Select other trigger settings as needed.

4. Click Start.  All packets, except Isochronous packets, are captured in the capture

buffer and then displayed in the Event List / Transaction Viewer window.

To ignore all Cycle Start packets

1. On the Trigger menu select New Capture.  The Trigger window appear.

2. On the General tab clear the Log Cycle Start check box.

3. Select other trigger settings as needed.

4. Click Start.  All packets, except cycle start packets, are captured in the capture

buffer and then displayed in the Event List / Transaction Viewer window.



4-3IM 703425-01E

4

C
ap

tu
rin

g
 P

ackets

4.2  Capturing Packet Scenarios

Setting External Hardware Trigger Conditions
Use the Ext. Trigger check box to trigger on an incoming pulse.  The end of the packet

after the pulse will be marked as a triggered packet.

Use the Enable Ext. Trigger Out box to generate a pulse of  5 volts and 150 ns in

length after a trigger condition is met.

These options are mutually exclusive—cannot be selected together.

To set an external hardware trigger in condition

1. Connect a device to the BNC connector on the left-hand side of the VK9000.

2. On the Trigger menu select New Capture.  The Trigger window appear.

3. On the General tab of the Trigger window click on the Ext Trigger check box on

Basic Triggers box.

4. Set other conditions as needed

5. Click Start.  All packets, except Isochronous packets, are captured in the capture

buffer and then displayed in the Event List / Transaction Viewer window.

Note
Requires a device capable of generating a pulse. There is a latency period between the

triggering event and the signal/pulse generation.

To set an external hardware trigger out condition

1. Connect a device to the BNC connector on the left-hand side of the VK9000.

2. On the Trigger menu select New Capture.  The Trigger window appear.

3. On the General tab of the Trigger window click on the Enable Ext. Trigger Out

check box on the Capture Options box.

4. Set other conditions as needed

5. Click Start.  All packets, except Isochronous packets, are captured in the capture

buffer and then displayed in the Event List / Transaction Viewer window.

Note
Requires a device capable of receiving a pulse.
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4.3 General Trigger Conditions

Trigger Conditions
The purpose of a trigger is to stop the data capture process when a specified event

occurs (or stop n events after the trigger event has occurred).  Define a trigger event by

selecting the Trigger window. The purpose of most of the controls on the tabs of the

Trigger window is to define the trigger events that stop the capture (in many cases you

can define multiple trigger events). For example, you can specify that the trigger event is

either a Read Quadlet Request or a Read Block Request.

Some of the types of events you can trigger on are:

• Any Asynchronous packet sent to a specific node or to one of several specified nodes

• Any Asynchronous packet sent from a specific node or from one of several specified

nodes

• Any Asynchronous packet of a specific type or one of several specified types

• Bad CRC values, incorrect Iso data lengths or invalid Tcodes

• Packets containing one or two specified quadlets at a specified offset

• Asynchronous packets containing one or more specified Transaction Labels,

Transaction Codes or Retry Codes

• Asynchronous packets containing a specified value in the Destination Address Low /

High field

• Isochronous packets containing one or more specified Channel numbers, Sync

Codes, Tags, and Payload Lengths

• Conditional or statistical events

General Trigger Conditions
The General tab contains two types of information:

• Triggering features common to all packet types

• Capture options

Trigger Window General Tab
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Trigger Window: General Tab Control Settings
Basic Trigger box

Item Description

Asyn A shortcut for the Enable Asynchronous Packet Triggering check box
on the Asynchronous tab.

Iso A shortcut for the Enable Isochronous Packet Triggering check box on
the Isochronous tab.

Phy A shortcut for the Enable PHY Packet Triggering check box on the Phy
Layer tab.

Payload Trigger on the presence of one or two quadlets in a packet at a
specified location.  Use the Value, Mask, and Offset fields to specify the
search criteria

Error Trigger on a CRC error (header or payload), incorrect Iso length, or
invalid Tcode

External Trigger In Trigger on a pulse via the BNC connector from an external hardware
device.

Extended Triggers box

Item Description

Statistical Trigger conditions used to log the number of packets after the initial
trigger condition is met.

Conditional Set a second and third trigger condition once the first condition is met.

AV/C Trigger on an AV/C packet.  Use the AV/C tab to customize capture
settings.

IPv4 Trigger on an IPv4 packet.  Use the IPv4 tab to customize capture
settings.

Extended button Click to open the Extended Trigger window and use the Statistical,
Conditional, AV/C and IPv4 tabs to customize capture settings.

Capture Options box

Item Description

Force Bus Reset Forces a bus reset.  The purpose of this feature is to capture Self ID
packets.

Log Cycle Starts Clear the Log Cycle Start check box, to ignore Cycle Start packets and
not capture them.
When the Log Cycle Start check box is selected, Cycle Start packets
are captured.
Note: If the Log Cycle Start check box is cleared, the VK9000’s

internal clock cannot synchronize with the timing of the
Cycle Master. This condition may affect the accuracy of the
packet timestamps.

Log ISO Packets Clear the Log Iso Packets check box to ignore Isochronous packets.
During the capture, the Event Counter in the Gathering data window is
advanced each time an Isochronous packet is encountered; the
Isochronous packets, however, are not captured.
When the Log Iso Packets check box is selected, Isochronous packets
are captured.

Enable External Trigger on an event and generate a 5 volt 150 ns in length pulse.
Trigger Out

Stop After Enter an absolute limit to the number of packets to be captured.
Specifying 0 sets the limit to the full capacity of the capture buffer.

Ignore Enter the number of packets ignored before the trigger is armed.

4.3  General Trigger Conditions
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Buffer Organization box

Item Description

Buffer Fill Select to use the Buffer Fill mode for capturing packets.

Rotational Select to use the Rotational Buffer Fill mode for capturing packets.

Before Trigger Specifies the number of packets to maintain in the capture buffer
prior to the trigger event.  This field is used in Rotational Buffer
Mode only, and is disabled in Buffer Fill Mode.  See Rotational
Buffer Mode for more information.

After Trigger Specifies the number of packets to capture after the Trigger event
occurs.

Load Trigger Setting box

Item Description

Load Trigger Setting list Loads a set of trigger conditions saved as a file.

Browse button Click to select trigger settings saved as a file.

Save Trigger Setting button Save the set of trigger conditions currently selected in the Trigger
window.

Setting General Trigger Conditions
To trigger on an intermittent problem

1. On the Trigger window General tab click the Rotational radio button.

2. In the Before Trigger field enter the number of packets captured before the trigger

event.

3. In the After Trigger field enter the number of packets captured after the trigger

event.

4. Verify that the value in the Stop After ______ Packets is 0 or is greater than the

sum of the Before Trigger and After Trigger fields.

5. Select other settings as needed.

6. Option: if desired, click the Save Trigger Setting to save the trigger settings for

future use.

7. Click Start.

4.3  General Trigger Conditions
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4.4 Asynchronous Trigger Conditions

Trigger conditions specific to Asynchronous packets are on the Asynchronous tab.

If trigger conditions are specified for more than one of the following properties, then the

VK9000 ANDs the specified properties to create the trigger.  For example, if Destination

ID is specified as 2, and Transaction Code is specified as Read Quadlet Request, then

the trigger condition is met only when a packet is encountered with a Destination ID of 2

and a Transaction Code of Read Quadlet Request.

You can also specify multiple values for each property, separated by commas.  In this

case, the VK9000 ORs the values together. The trigger condition is met when any of the

specified value(s) is encountered.  For example, you could enter 2, 3, 4 in the

Destination ID, and the trigger condition would be met when a packet is set to Node 2, 3,

or 4.

Trigger Window: Asynchronous Tab Control Settings
The controls on the Trigger window Asynchronous tab are described in the following

section.

Trigger Window Asynchronous Tab
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Item Description

Enable Asynchronous Select to trigger on Asynchronous packets.  Then further qualify
Packet Triggering triggering conditions by setting other capturing condition.  If no other

properties are specified, then the trigger is set for any
Asynchronous packet. This check box and the Async check box on
the General tab are the same.

Destination ID Select to trigger on packets with the specified destination ID. If
multiple destination IDs are entered, then the trigger is set for any
values entered.

Source ID Select to trigger on packets with the specified source ID. If multiple
source IDs are entered, then the trigger is set for any values
entered.

Transaction Label Select to trigger on packets with the specified Transaction Label.  If
multiple Transaction Labels are entered, then the trigger is set for
any values entered.

Transaction Code Select to trigger on packets with the specified Transaction Code.
Click the … button to select from a list of valid Transactions by
name. If multiple Transaction Codes are selected, then the trigger is
set for any of values entered.

Retry Code Select to trigger on packets with the specified Retry Code. Click the
… button to select from a list of valid Retry Codes by name. If
multiple retries are selected, then the trigger is set for any of values
selected.

Destination Address Low Select to trigger on packets containing the specified value in their
Destination Address Low field.

Ack Code Select to trigger on packets with the specified Ack Code. Click the
… button to select from a list of valid Ack Codes by name. If
multiple Ack Codes are selected, then the trigger is set for any of
values selected.

Setting Asynchronous Trigger Conditions
To trigger on the presence of a specific packet type (such as a Read Quadlet

Request) from a specific node

1. Click the Asynchronous tab on the Trigger window.

2. Select Enable Asynchronous Packet Triggering check box.

3. Click the … button next to the Transaction Code field and select the desired

transaction type from the list.

4. Enter the Node ID of the desired node in the Source ID field.

5. Select other settings as needed.

6. Click Start.

4.4  Asynchronous Trigger Conditions
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4.5 Isochronous Trigger Conditions

If trigger conditions are specified for more than one of the following properties, then both

values are used to create the trigger.  For example, if Channel is specified as 2, and

Data Length is specified as 10, then the trigger condition is met only when a packet is

encountered with a Channel number of 2 and a Data Length of 10.

You can also specify multiple values for each property, separated by commas.  In this

case, the trigger condition is met when any of the specified values are encountered.  For

example, you could enter 2,3,4 in the Channel field, and the trigger condition would be

met when an Iso packet is encountered on channel 2 or channel 3 or channel 4.

Trigger Window: Isochronous Tab Control Settings
Use the controls on the Isochronous tab to set trigger conditions for Isochronous packet

capturing.

Trigger Window Isochronous Tab

Item Description

Enable Isochronous Select to trigger on Isochronous packets.  Then further qualify
Packet Triggering triggering conditions by setting other capturing conditions.  If no other

properties are specified, then the trigger is set for any Isochronous
packet. This check box and the Iso check box on the General tab are
the same.

Channel Select to trigger on packets with the specified Channel code.  If multiple
Channel numbers are entered, then the trigger is set for any values
entered.  Separate multiple channel numbers with commas.

Sync Code Select to trigger on packets with the specified Sync code.  If multiple
Sync code numbers are entered, then the trigger is set for any values
entered.  Separate multiple channel numbers with commas.

Tag Select to trigger on packets with the specified Tag.  If multiple tags are
entered, then the trigger is set for any of the values entered.  Separate
multiple Tags with commas.

Data Length Select to trigger on packets with the specified payload length.  Separate
multiple data length values with commas.



4-10 IM 703425-01E

Setting Isochronous Trigger Conditions
To trigger on an Isochronous packet containing a specific Channel number

1. On the Trigger window click the Isochronous tab.

2. Select the Enable Isochronous Packet Triggering check box.

3. Enter the desired Channel number in the Channel field.

4. Select other settings as needed.

5. Click Start.

To trigger on an Isochronous packet containing a specific Sync Code

1. On the Trigger window click the Isochronous tab.

2. Select the Enable Isochronous Packet Triggering check box.

3. Enter the desired Sync Code in the Sync Code field.

4. Select other settings as needed.

5. Click Start.

To trigger on an Isochronous packet containing a specific Tag value

1. On the Trigger window click the Isochronous tab.

2. Select the Enable Isochronous Packet Triggering check box.

3. Enter the desired Tag value in the Tag field.

4. Select other settings as needed.

5. Click Start.

To trigger on an Isochronous packet containing a payload of a specific length

1. On the Trigger window click the Isochronous tab.

2. Select the Enable Isochronous Packet Triggering check box.

3. Enter the payload length in the Data Length field.

4. Select other settings as needed.

5. Click Start.

4.5  Isochronous Trigger Conditions
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4.6 PHY Trigger Conditions

PHY Trigger Conditions
Trigger conditions specific to PHY packets are on the Phy Layer tab.

Trigger Window: PHY Tab Control Settings
Use the controls on the Phy Layer tab to create trigger conditions for capturing PHY

packets.

Trigger Window PHY Layer Tab

Item Description

Enable PHY Packet Triggering Select to trigger on PHY packets. Select other properties to
further qualify the triggering event. If no other properties are
specified, then the trigger is set for any PHY packet. This check
box and the PHY check box on the Trigger window General tab
are the same.

Self ID Select to trigger on Self ID packets.

Link On Select to trigger on Link On packets.

Configuration Select to trigger on Configuration packets.

Ping Select to trigger on Ping packets.

Remote Access Select to trigger on Remote Access packets.

Remote Reply Select to trigger on Remote Reply packets.

Remote Command Select to trigger on Remote Command packets

Remote Confirmation Select to trigger on Remote Confirmation packets.

Resume Select to trigger on Resume packets.

Node ID Select to trigger on PHY packets containing the specified Node
IDs.

Setting PHY Trigger Conditions
To trigger on a specific type or types of PHY packets from a specific node

1. On the Trigger window click the PHY Layer tab.

2. Select the Enable PHY Packet Triggering check box.

3. Select the appropriate PHY packet check boxes as needed.

4. Enter the desired Node ID in the Node ID field.

5. Click Start.
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4.7 Trigger Window: Payload Tab Control Settings

Use the Payload tab to set up trigger conditions for a packet’s payload.

Trigger Window Payload Tab 

Item Description

Enable Payload Trigger Select to set a payload trigger.  This check box is the same as the
Payload check box on the General tab.

1st Quad box

Item Description

1st Quad check box Select to set trigger data for the first quadlet.

Value Search for a specific first quadlet value.  The value must be entered in
hexadecimal, and must be exactly one quadlet (eight characters) in
length.

Mask A mask used to specify that certain bits in 1st Quad Value are to be
ignored.  The mask must be exactly one quadlet (eight characters) in
length.  A 0 bit in the mask means that the corresponding bit in 1st
Quad Value is to be ignored.  For example, a 1st Quad Mask of
00FFFF00 specifies that the first and last bytes of the 1st Quad Value
are ignored.

Offset Offset from the beginning of the packet to search for 1st Quad Value.

Logic box

Item Description

AND Select AND to specify that the trigger condition is met only if the packet
contains both quadlets

OR To trigger on just a single quadlet, select OR and set the 2nd Quad
Mask to 00000000.
Select OR to specify that the trigger condition is met if the packet
contains either quadlet.
To trigger on just a single quadlet, select OR and set the 2nd Quad
Mask to 00000000.
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2nd  Quad box

Item Description

2nd Quad check box Select to set trigger data for the second quadlet.

Value Search for a specific second quadlet value.  The value must be entered
in hexadecimal and must be exactly one quadlet (eight characters) in
length.

Mask A mask used to specify that certain bits in 2nd Quad Value are to be
ignored.  The mask must be exactly one quadlet (eight characters) in
length.  A 0 bit in the mask means that the corresponding bit in 2nd
Quad Value is to be ignored.  For example, a 2nd Quad Mask of
00FFFF00 specifies that the first and last bytes if the 2nd Quad Value
are to be ignored.

Offset Offset from the beginning of the packet to search for 2nd Quad Value.

To trigger on the presence of one specific quadlet at a specific offset in a packet

1. Select the Payload tab on the Trigger window tab and select the Enable Payload

Trigger check box.

2. Select the 1st Quad check box and enter a quadlet value in the 1st Quad Value

field.

3. If needed, enter a value in the 1st Quad Mask field.

4. Enter the offset in hexadecimal in the 1st Quad Offset field.  The offset must be

from the beginning of the packet.

5. Click the OR button and enter 00000000 in the 2nd Quad Mask field.  (This setting

is used to search for only the first quadlet.)

6. Select other settings as needed.

7. Option: if desired, click the Save Trigger Setting on the General tab to save the

trigger settings for future use.

8. Click Start.

To trigger on the presence of a pair of quadlets

1. Select the Payload tab on the Trigger window and select the Enable Payload

Trigger check box.

2. Select the 1st Quad check box and enter quadlet values for 1st Value, 1st Mask,

and 1st Offset.

3. Select the AND radio button.

4. Select the 2nd Quad check box and enter quadlet values for 2nd Value, 2nd Mask,

and 2nd Offset.

5. Select other settings as needed.

6. Option: if desired, click the Save Trigger Setting to save the trigger settings for

future use.

7. Click Start.

To trigger on the presence of either of two quadlets
1. Select the Payload tab on the Trigger window and select the Enable Payload

Trigger check box.
2. Select the 1st Quad check box and enter quadlet values for 1st Value, 1st Mask,

and 1st Offset.
3. Select the OR radio button.
4. Select the 2nd Quad check box and enter quadlet values for 2nd Value, 2nd Mask,

and 2nd Offset.
5. Select other settings as needed.
6. Option: if desired, click the Save Trigger Setting to save the trigger settings for

future use.
7. Click Start.

4.7  Trigger Window: Payload Tab Control Settings
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4.8 Trigger Window: Error Tab Control Settings

Trigger on a CRC error (header or payload), DMA Error, and a truncated (length doesn’t

match) packet.

Item Descripton

Enable Error Trigger Select to trigger on a CRC, data length, or DMA error.

Header CRC Error Select to trigger on a CRC error in the header.

Data CRC Error Select to trigger on a CRC error in payload.

Packet Truncation Select to trigger on a data length error.

DMA Error Select to trigger on a DMA error.
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4.9 Setting Extended Triggers

Extended Trigger Window Overview
Use the Extended Trigger window to load a statistical or conditional trigger condition or

create a trigger condition for AV/C or IPv4 packets.  The window has four tab sections:

the Statistical tab, Conditional tab, AV/C tab, and IP tab.

To set a statistical trigger

1. On the Trigger window click the General tab.

2. Click the Extended button and select the Statistical tab.

3. On the tab click the Browse button.  The Open dialog box appears.

4. Select a file from the list and click Open.

To set a conditional trigger
Note

Before loading a statistical trigger, use the controls on the Trigger window tabs to create and

save a particular trigger.

1. On the Trigger window click the General tab.

2. Click the Extended button and select the Conditional tab.

3. On the tab click the Browse button.  The Open dialog box appears.

4. Select a file from the list and click Open.

To set an AV/C trigger
Note

Before loading a statistical trigger, use the controls on the Trigger window tabs to create and

save a particular trigger.

1. On the Trigger window click the General tab.

2. Click the Extended button and select the AV/C tab.

3. On the AV/C tab click the Enable AV/C Trigger check box.

4. Option: use the AV/C Trigger list to select a type of AV/C packet.

5. Select either the Command or Response option buttons.

6. Select either the Write block or Write quadlet option buttons.

7. Select and enter values in the AV/C lists and check boxes.  Choices include: cts

check box and field, ctype check box and list, Response check box and list,

Subunit check box and field, Opcode check box and field, and Operand0 check

box and field.

8. Click the Basic button.

9. Option: click the Save Trigger Setting button to save to a file trigger conditions.

10. On the General tab click OK. The Trigger window closes and data capture begins.
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To set an IP trigger

1. On the Trigger window click the General tab.

2. Click the Extended button and select the IPv4 tab.

3. On the IPv4 tab click the Enable IP Trig check box.

4. Select either the Asy radio button or the Iso radio button.

5. On the IP Payload box select ARP, MCAP, or Datagram radio buttons.

6. Select values and enter data in the ARP/MCAP box or the Datagram box to further

qualify the trigger.

7. Click the Basic button.

8. Option: click the Save Trigger Setting button to save to a file trigger conditions.

9. On the General tab click OK. The Trigger window closes and data capture begins.

Statistical Tab Controls

Use the controls on the Statistical tab to customize trigger conditions to log individual

events in the Event List.

Extended Trigger Window Statistical Tab

Item Description

Enable Statistical Trigger Select to set a statistical trigger.

Browse Using the Browse button select a trigger condition saved to a file.
The trigger condition is displayed in the Trigger field.

Trigger Click to select a trigger condition saved to a file.

4.9  Setting Extended Triggers
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Conditional Tab Controls

Use the controls on the Conditional tab to customize trigger conditions to create a

second or a third trigger condition that occurs once the first or second trigger conditions

are met.

Extended Trigger Window Conditional Tab

Item Description

Enable Statistical Trigger Select to set a statistical trigger.

Trigger 0 Reflects the trigger set on the other trigger tab (that is, the Basic
tab).

Trigger 1 Using the Browse button select a trigger condition saved to a file.
The trigger condition is displayed in the Trigger 1 field.

Last Trigger Select to set Trigger 1 as the last Conditional trigger condition.  If
cleared, Trigger 2 is the last Conditional trigger condition.

Trigger 2 Using the Browse button select a trigger condition saved to a file.
The trigger condition is displayed in the Trigger 2 field.

Browse Click to select a trigger condition saved to a file.

4.9  Setting Extended Triggers
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AV/C Tab Controls

Use the controls on the AV/C tab to set AV/C trigger conditions.

Extended Trigger Window AV/C Tab

Item Description

Enable AV/C Trigger Select to set an AV/C trigger.

Enable AV/C Trigger list Select an AV/C unit or subunit.

Command Select to trigger on a Command frame.

Response Select to trigger on a Response frame.

Write block Select to trigger on a Write Block Request packet.

Write quadlet Select to trigger on a Write Quadlet Request packet.

Stream Select to trigger on a Stream packet.

cts check box and cts field Select to trigger on the cts value (0 is the default value) and if
desired, enter a value (0-15 in the cts field).

ctype check box and ctype list Select to trigger on the ctype (command type) and select from the
list a ctype.

Response check box and Select to trigger on the response code and select from the list a
Response list response code.

Subunit check box and Select to trigger on the Subunit type and select from the list
Subunit list a Subunit.

Sub ID check box and Sub Select to trigger on the Subunit ID and enter a Subunit ID value (0-
ID field 7).

Opcode check box and Select to trigger on the Opcode and enter an Opcode value in
Opcode field hexadecimal.

Operand0 check box and Select to trigger on the Operand 0 and enter an Operand 0 value in
Operand0 field hexadecimal.

4.9  Setting Extended Triggers
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4.9  Setting Extended Triggers

IPv4 Tab Controls

Use the controls on the IPv4 tab to set IP trigger conditions.

Extended Trigger Window IPv4 Tab

Item Description

Enable IP Trig check box Select to enable IP packet triggering.

Asy radio button Select to trigger on an Asynchronous packet containing an
IP payload.

Stream radio button Select to trigger on a Stream packet containing an IP
payload.

GASP check box Select to trigger on IPv4 GASP.

IP Payload box

Item Description

ARP radio button Select to trigger on an ARP packet.

MCAP radio button Select to trigger on an MCAP packet.

Datagram radio button Select to trigger on an IP datagram.
By trigger type set, applicable box becomes possile.

ARP/MCAP box

Item Description

opcode check box and opcode list Select and enter an opcode value for triggering.

Sender check box and Sender field Select and enter a sender value for triggering.

Length check box and Length field Select and enter a length value for triggering.

Datagram box

Item Description

lf check box and lf list Select the lf check box and select from the list a type of
datagram for triggering.  Choices include: Unfragmented,
First, Last, and Interior.

Buffer check box and Buffer field Select and enter a buffer value for triggering.

dgl check box and dgl field Select and enter a dgl value in hexadecimal for triggering.
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Saving Trigger Settings
To save trigger settings

1. Click the General tab on the Trigger window.

2. Click the Save Trigger Setting button.  The settings are saved with the file

extension trg; the default directory is c:\dpx\settings.

Loading Trigger Settings
To load trigger settings using the Load Trigger Setting list

1. On the Trigger window click the General tab.

2. Select the Load Trigger Setting list.

3. Select a trigger setting from the list and click Open.

To load trigger settings using the Browse button

1. On the Trigger window click the General tab.

2. Option: click the Extended button and select the Statistical or Conditional tab.

3. On the tab click the Browse button.  The Open dialog box appears.

4. Select a file from the list and click Open.

4.9  Setting Extended Triggers
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5.1 Command and Status (CSR) Access

The CSR (Command Status Register) Architecture (ANSI/1212 1994 Edition)

standardizes the function of each node’s core CSRs and their location in the node’s

initial register space.  The addresses of these core registers are specified in terms of

offsets within the initial register space, where the offset of the start of initial register

space is FFFF F000 000016.

The VK9000 provides two facilities for browsing or reading any node’s CSR or Config

ROM.  You can also modify any node’s CSRs without the need to know the registers’

addresses.

Use the CSR and Config ROM Explorer to view a node’s CSR registers or Config

ROM.  Use this feature to browse through any node’s Command and Status Registers.

More importantly, you can browse the directory Hierarchy of any node’s Config ROM,

traversing up and down the hierarchy’s tree structure.  The contents of each directory

and leaf are decoded and displayed in an easy-to-read format.

Users can also perform Read, Write, and Lock commands to write to a Node’s CSR

registers.  These features are discussed in Node Info Window: CSR section of the

Topology Window chapter.

Chapter 5 Examining Node and Packet Contents
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5.2 CSR and Config ROM Explorer Overview

Use the CSR and Config ROM Explorer to browse through any node’s register space

and decode its contents into an easily readable format.  Using the CSR and Config

ROM Explorer, you can:

• Display and decode the contents of any node’s CSR registers

• Display and decode the contents of any node’s serial bus defined registers

• Display and decode any node’s Bus Information Block

• Browse any node’s directory structure, displaying each directory’s contents in an

easily readable format

The CSR and Config ROM Explorer contains four sections: Raw Hex Register

Display, Register Selection, Response, and Formatted Register Display.

CSR and Config ROM Explorer Window

To Open the CSR and Config ROM Explorer

• Double-click the right-hand section of a node.  If the node shows only node ID and

speed data click the gray arrow to enlarge the node, then double-click the right-hand

section.  The CSR and Config ROM Explorer appears.
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5.2  CSR and Config ROM Explorer Overview

Raw Hex Register Display
The right section displays the node’s register space in raw hexadecimal form.  The left

column is the offset from the beginning of the register space, and the right column is the

quadlet of that offset.

If one or more quadlets are highlighted, they correspond to the highlighted field in the

Register Selection window of the display.

Raw Hex Register display Window

 Register Selection Window
The Register Selection window appears in the left section of the CSR and Config ROM

Explorer.

The register space is displayed in a tree view.  A + indicates a branch of the tree that can

be expanded (by clicking the +).

When you select a register in the Register Selection window, the contents of that

register appear in the Raw Hex Register Display and the Formatted Register Display.

Register Selection Window
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Formatted Register Display
The Formatted Register Display occupies the center section of the CSR and Config

ROM Explorer.

It displays the contents of the register highlighted in the Formatted Register Selection

window. The upper portion displays the register contents in a manner consistent with the

1394 Standard document. The lower portion displays the register contents in an easily-

readable format.

The Formatted Register display shows the contents of the selected node’s Bus

Information Block.  The lower portion displays the bus information block in an easily-

readable format.

Formatted Register Display Window

Response Box
The Response box, which occupies the lower right corner of the CSR and Config ROM

Explorer window, lists the type of response packet.

Response Box

5.2  CSR and Config ROM Explorer Overview
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CSR and Config ROM Explorer Procedures
To display a node’s Bus Information Block

1. Double-click the right-hand section of a node.  If the node shows only node ID and

speed data click the gray arrow to enlarge the node, then double-click the right-

hand section.  The CSR and Config ROM Explorer appears.

2. If there is a plus sign (+) next to Config ROM in the Register Selection window,

click it to expand the Config ROM branch.

3. Select Bus_info_block in the Register Selection window.

To display a node’s Control and Status Registers (CSR)

1. Double-click the right-hand section of a node.  If the node shows only node ID and

speed data click the gray arrow to enlarge the node, then double-click the right-

hand section.  The CSR and Config ROM Explorer appears.

2. If there is a plus sign (+) next to CSR in the Register Selection window, click it to

expand the CSR branch.

3. Select a register to view in the Register Selection window.  The Formatted

Register display shows the contents of the selected register.  The lower portion

displays the register in an easily-readable format.

To display a node’s Serial Bus defined Registers

1. Double-click the right-hand section of a node.  If the node shows only node ID and

speed data click the gray arrow to enlarge the node, then double-click the right-

hand section.  The CSR and Config ROM Explorer appears.

2. If there is a plus sign (+) next to Serial Bus in the Register Selection window,

click to expand the Serial Bus Register branch.

3. Select the register you want to view in the Register Selection window. The

Formatted Register display shows the contents of the selected Serial Bus

Defined Register.  The lower portion displays the register in an easily-readable

format.

To display a node’s Config ROM directory Structure

1. Double-click the right-hand section of a node.  If the node shows only node ID and

speed data click the gray arrow to enlarge the node, then double-click the right-

hand section.  The CSR and Config ROM Explorer appears.

2. If there is a plus sign (+) next to Config ROM in the Register Selection window,

click to expand the Config ROM branch.

3. If there is a plus sign (+) next to Root_directory in the Register Selection

window, click to expand the directory branch.  The expanded directory branch

displays the first-level unit directories and leaves.

4. Option: if desired, continue to expand lower-level directories. The contents of the

desired directory or leaf appear in the Formatted Register Display.

5. Option: for directories, if the upper portion of the Formatted Register Display is

not large enough to show the entire directory, use the next and previous buttons

to browse the directory.

5.2  CSR and Config ROM Explorer Overview



5-6 IM 703425-01E

5.3 Data Explorer

The Data Explorer is a powerful tool used to search, display, and analyze 1394 packets.

Double-click any packet in the Event List / Transaction Viewer to display it in the Data

Explorer.  The Data Explorer can:

• Display packet data in hexadecimal

• Display packet header information consistent with the 1394 Standard document

• Decode packet header fields

• Determine and display packet type

• Display the packet payload in hexadecimal, ASCII, or binary

• If the packet payload contains a higher-level protocol, such as IEC61883, SBP-2, AV/

C, IPv4, HAVi or Customize decode it (optional feature:SBP-2, AV/C, IPv4, HAVi,

Customize)

• Search for other packets with similar contents

• Search for other packets with identical header fields

After opening the Data Explorer window, you can use it to examine any packet in the

capture buffer.  Simply scroll through the Event List / Transaction Viewer and select a

packet(s).

The Packet Index number shown in the title bar corresponds to the packet’s index value

shown in the Event List / Transaction Viewer.

The Data Explorer contains five sections: Raw Packet box, Packet Time box, Packet

Format box, Ack Data box, and Protocol Selection list.

Note
About the detail of Customize function, refer to Chap.7.

Data Explorer Window
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Raw Packet Box
The Raw Packet box, which appears in the right section of the Data Explorer, displays

the contents of the 1394 packet in hexadecimal.

The left column of the Raw Packet box displays the offset from the beginning of the

packet.  The right column is the packet contents.

Raw Packet Box

Packet Time Box
The Packet Time box, which appears in the lower right corner of the Data Explorer,

displays the following information about each packet:

Item Description

Sec Timestamp, marking the end of the packet.

Cycle Number of ticks from cycle start to the beginning of the packet. This value is
calculated by subtracting the Transmission time from the Sec/Cycle/Tick
timestamp.

Tick The packet transmission time in Ticks.

Packet Time Box

5.3  Data Explorer
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Packet Format Box
The Packet Format box appears in the center section of the Data Explorer display.

The upper portion of the Packet Format box displays the packet type and the bit fields of

the packet in a manner consistent with the 1394 Standard document.  The lower portion

of the Packet Format box provides a display of the decoded values with a description.

Select the radio buttons above the Packet Format box to display either the packet’s

header or its payload.  The payload can be displayed in hexadecimal, binary, or ASCII.

Packet Format Box

Ack Data Box
The Ack Data box, which appears in the right section of the Data Explorer, is used to

display acknowledge packet data.

Ack Data Box

Protocol Selection List
The Protocol Selection list, which appears in the left section of the Data Explorer, is

used to select a protocol to decode the packet shown in the Packet Format box.

Typically, select 1394-1995 protocol.

Protocol Selection List

Stick to Same Protocol Box
The Stick to Same Protocol box, which appears in the left section of the Data

Explorer, is used to keep the same protocol selected while switch between or opening

different packets in the Data Explorer during a concurrent session.

5.3  Data Explorer
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5.4 Parsing and Analyzing Packets

To view packet data in the Data Explorer

• On the Event List or Transaction Viewer, double-click a packet.  The Data Explorer

window opens.

To view 1394 packet contents such as AV/C, IP, HAVi, SBP-2

Requirements

A registered version of the desired protocol plug-in.  The plug-in, for instance AV/C, is

used to parse the 1394 packet to examine the encapsulated protocol.

1. On the Event List or Transaction Viewer, double-click a packet.  The Data

Explorer window opens.

2. From the Protocol Selection list in the Data Explorer, click the appropriate

protocol.  The protocol data appears in the Data Explorer.

To enable protocol recognition in the Event List

1. On the View menu select Display Options.  The Display Options window

appears.

2. On the Display Options window click the Protocols tab and select Enable

Protocol Display in Event List.  As needed, select other settings including AV/C,

IPv4, SBP2, IEC 61883, and HAVi.

3. Click OK.

To configure SBP-2 parsing
Note

This procedure must be completed before parsing any SBP-2 packets in the Data Explorer.

Once configured, parse SBP-2 packets like any other packets—reconfigure if your SBP-2

testing needs demand it.

1. Using the keyboard mouse or an external mouse right-click in the Event List and

from the menu select SBP-2 parser option.   The SBP-2 parser option window

appears.

2. Either accept the default management agent settings or specify the command

block agent base address.

3. Click OK.  SBP-2 can be parsed in the Data Explorer.

To select Stick to Same Proto

Select the Stick to Same Proto check box to select a protocol other than 1394 as the

default; the protocol selected will become a temporary default setting. This feature is

especially useful when comparing and analyzing multiple packets. Closing the Data

Explorer window clears the selected setting from the check box.

1. From the Protocol Selection list in the Data Explorer window, click AV/C.

2. Select Stick to Same Proto check box.

3. Select the Event List / Transaction Viewer window and press the UP ARROW

key and DOWN ARROW key to select other packets from the Event List, without

the protocol setting returning to 1394-1995.
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Saving Captured Packets
You can save the packet appearing in the Data Explorer for later use when generating

packets.

To save a packet appearing in the Data Explorer

1. On Data Explorer window click the Save Packet button.  The Save As dialog box

appears.

2. Click Save.

Reassembling IP Fragments
Use the IP Defragment Button to open the Reassembled IP Datagram dialog box.

The Reassembled IP Datagram dialog box provides controls to reassemble IP packets.

An IP datagram is fragmented into three sections: a first, an internal (or multiple), and a

last.  This feature provides a way to reassemble the packets into a datagram and then

save the datagram or export it using a customized DLL.

To reassemble IP fragments

1. On the Data Explorer window, select IP protocol.

2. Click the IP Defragment button.  The Reassembled IP Datagram dialog box

appears.  Data displayed includes the IP payload and the number of fragments

reassembled.

3. Option: click the Binary button to save in binary.  The Hex button is the default

setting and saves the datagram in hexadecimal.

4. To save the packet, enter a name for the datagram and click the Save button.  The

Save As dialog box appears.

5. Click Save.

Reassembled IP Datagram Window

Using the Custom IP Decoder

Users can also customize the IP Parser to call a DLL to handle or move a reassembled

IP datagram to a user defined location, window, or application. This feature simplifies

using IP data in other instances or applications.

Click the Using the Custom IP Decoder button to call the customized DLL and move

the reassembled IP packet to the customized location.  Before using this feature, users

must set up the DDL.  Use the following C code fragment as a model for setting up the

DLL. After compiling, the DLL needs to reside in the FWX root directory.

5.4  Parsing and Analyzing Packets
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Example

The following example is a sample C program for customizing the IP Decoder DLL.  Use

the exact same procedure signature (the first line of the following code fragment).  This

procedure is the entry point for the entire IP Decoder DLL, which means that the Data

Analyzer will call this function if the Custom IP Decoder button is clicked.  The

parameters are: data is a pointer to IP payload, and len is the length of data in bytes.

#include <windows.h>

extern”C”__declspec(dllexport) BOOL IPDecoder (unsigned long *data, int len)

{

// you could do whatever you want with data here

MessageBox(NULL,”This is in DLL”,””,MB_OK);

return TRUE

}

5.4  Parsing and Analyzing Packets
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5.5 Searching For Packets

The Data Explorer contains a very powerful search tool. You can search for other

packets in the capture buffer containing the same or similar contents.  You can also

search for packets containing one or more identical header fields.

Searching for Packets by Content
Use the Raw Packet box and the Find Packet by Data button to search for packets by

content.

Data Explorer Window Raw Packet Box

You can also search for packets containing one or more identical quadlets at the same

offset.  This is useful when, for example, you want to find packets containing the same

payload, but with different headers.  You can also search for packets with similar

payloads (partial match).

Use the Data Explorer to modify search criterion.  You can, for instance, specify a

quadlet(s) to search for, modify it, and then perform a search based on the modified

quadlet.

Data Explorer Window Raw Packet Box

To find an identical packet in the capture buffer

1. On the Raw Packet box drag the pointer to select all entries.

2. Select the Up or Down radio button to search the contents of the capture buffer

preceding or following the current packet.

3. Click the Find Packet by Data button.

To find a packet with identical quadlets at the same offset

1. On the Raw Packet box drag the pointer to select the quadlet(s) and offset(s).

2. Select the Up or down radio button to search the capture buffer preceding (Up) or

following (Down) the current packet.

3. Click the Find Packet by Data button.

To modify the search criterion
1. On the Data Explorer window select the Hex radio button.

2. On the Raw Packet box drag the pointer to select one or more quadlets.
3. On the Data Explorer window select the Edit Data check box. The bottom portion

of the Packet Format box is replaced by the Edit Data Below box.

4. Click in Edit Data Below box.  The selected quadlet(s) appear.
5. Edit the quadlets to create search criterion.
6. On the Data Explorer window select the Up or Down radio button to search the

contents of the capture buffer preceding or following the current packet.
7. Click the Find Packet by Data button.
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Searching for Packets by Header Field
• Use the Find Packet by Field check box to search for packets containing identical

header fields.

Data Explorer Window Find Packet by Field

To find a packet with one or more identical header fields

1. On the Data Explorer window select the Find Packet by Field check box. The

Matching Fields box appears.

2. On the Matching Fields box, select the appropriate check boxes to use for search

criteria.

3. Select either the AND or the OR radio button.  Select AND to set the search criteria

so that all checked fields must match.  Select OR to set the search criteria so that

any of the checked fields must match.

4. Select the Up or Down radio button to search the contents of the capture buffer

preceding (Up) or following (Down) the current packet.

5. Click the Find Packet by Data button.

Data Explorer Display Options: Start with Header Viewer vs. Start with Payload Viewer
Use these optional settings to specify whether the Packet Format box on the Data

Explorer window initially displays the packet’s header or displays the packet’s payload in

hexadecimal.

To select header or payload display options

1. On the View menu select the Display Options command.  The Display Options

window appears.

2. On the Data Details tab, select either the start with Header Viewer or start with

Payload viewer radio button.

Data Explorer Display Options: Quadlets per Line in Payload View
When displaying the packet’s payload in hexadecimal, you can specify the number of

quadlets per line.

To specify the number of quadlets displayed for a packet’s payload

• On the Number of data quadlets per line in Payload viewer box, click the

appropriate number.

5.5  Searching For Packets
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5.5  Searching For Packets

Data Explorer Display Options: Classic Details Window
The Classic Detail window displays packet information in a simplified format. The

payload is shown in hexadecimal.

Classic Dtails Window

At the bottom of the window, the packet is displayed as a raw packet  (including one

quadlet for the packet header, one quadlet for the header CRC, n quadlets for the data

payload, and one quadlet for the payload CRC).

To select the Classic Details window

1. On the View menu select the Display Options command.  The Display Options

window appears.

2. On the Data Details tab, select the Classic Details Window radio button.
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6.1 Generating Traffic Overview

Using the Data Generator you can build and send a single packet or a sequence of

packets.  You can send Asynchronous, Isochronous, and PHY packets, and even build

illegal packets as well as valid packets.

The Data Generator feature is most powerful, however, when combined with the

VK9000’s data capture capability.  You can capture packets, modify them, and then

retransmit them.  You can even retransmit a stream of Isochronous packets, replaying a

stream you previously captured.

Specifying Data Generator Node Capabilities
Because the VK9000 may be used in an environment where no other nodes are capable

of being Root, Cycle Master, or Isochronous Resource Manager, you can configure the

VK9000’s data Generation node to support one or more of these capabilities.

For more information, see Node Info Window: Node Tab Controls in the Topology

Window section.

Chapter 6 Generating 1394 Traffic



6-2 IM 703425-01E

6.2 Asynchronous Packet Generation

Asynchronous Packet Generation Overview
Use the Asynchronous tab on the Data Generator window to generate Asynchronous

packets.

Using the controls on this tab, you can:

• Build and send a 1394 packet, such as Read Quadlet Request, specifying the

destination Address Low

• Build and send a packet such as Read Quadlet Request or Write Quadlet Request,

specifying the payload and destination Address Low/Address High

• Build a packet and send it multiple times, specifying the delay between transmissions

if desired

• Build a packet with incorrect Header CRC and/or Payload CRC values

• Build a packet and save it for later re-use

• Send an Asynchronous packet from the Event List

• Create and send (and optionally save for later use) a sequence of packets

• Build a packet or a sequence of packets, send it and simultaneously switch to capture

mode

To open the data Generator window and select the Asynchronous tab

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. On the Data Generator window click the Asynchronous tab.

Tip

On the toolbar click the Data Generator button.
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6.2  Asynchronous Packet Generation

Data Generator Window: Asynchronous Tab Controls
Use the controls on the Asynchronous tab to generate a customized packet.

Data Generator Window Asynchronous Tab

Item Description

Packet Type Selects the type of Asynchronous packet to generate.  By selecting RAW
PACKET, you can specify the contents of the entire packet in the Payload
field, especially useful for custom packets.

Speed Selects the speed to use to send the packet.

Setup Trigger Button used to open the Trigger dialog box.

Header box on the Asynchronous tab

Item Description

Dest ID Specify the Destination ID of the packet.

Source ID Specify the Source ID of the packet.

Dest Offset Low Specify the contents of the packet’s destination Memory Address Low field.

Dest Offset Hi Specify the contents of the packet’s destination Memory Address Hi field.

Data Length Specify the contents of the packet’s data Length field.
If grayed out, the specified packet type has a fixed data length.

Header CRC Use this field to enter your own value for the Header CRC.  Using this
feature requires that the adjacent Manual Overwrite check box is selected.
If this field is grayed out (that is, if the Manual Overwrite check box is not
selected), the VK9000 uses the correct CRC value.

Tlabel Specify the Transaction Label.

Retry Specify the Retry Code.

Tcode Specify Transaction Code.

Pri Specify Priority.

Resp Code Response Code.  Used in Response packets.

Ext Tcode Extended Tcode.

Manual Overwrite Select to enter your own Header CRC value in the adjacent Header CRC
check box field.
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Payload box on the Asynchronous tab

Item Description

Payload Use this field to enter the packet’s payload.  If the packet type
implies a fixed data length, then enter the appropriate number of
bytes.
Note: Enter an even number of characters (that is, complete

bytes).  If an odd number of characters is entered, the
extra half byte is ignored.

CRC Use this field to enter your own value for the Payload CRC if the
adjacent Manual Overwrite check box is selected.  If this field is
grayed out (that is, if the Manual Overwrite check box is selected),
the VK9000 will use the correct CRC value.

Overwrite check box Select to enter your own CRC value in the adjacent CRC field.

Operation box on the Asynchronous tab

Item Description

Packet Name Save the specified packet to a file for reuse.
You can also reuse a packet saved to a file by clicking the Browse
button.

Repeat Use this field to send a specified packet more than once.  Specify
the number of times the packet is sent.

Delay Specify the delay in milliseconds between the repeat sending of a
packet.

Send/Capture Send the specified packet and then enter capture mode.

Send Send the specified packet. The Data Generator window remains
open.

Asy Packet Sequence box

Item Description

Build Use this button to create a sequence of packets.  Packets saved to
a file are used to build the sequence. The Asynchronous Sequence
Editor appears.

Sequence Name Name of the sequence to send.

Browse Load a previously saved sequence.

Delay Specify delay in milliseconds between each repeated sequence.

Repeat Specify the number of times the sequence is repeated. The default
setting value is 1.

Send/Capture Send the specified sequence of packets and enter capture mode.

Send Send the specified sequence of packets. The Data Generator
window remains open to specify and send, if needed, additional
packets.

6.2  Asynchronous Packet Generation
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Asynchronous Editor Window

Item Description

Sequence Name Enter a new sequence name or click the Browse button to select a
previously saved to a file sequence.

Current Directory Displays the current directory in which files are stored.

List of Asy Packets Box used to list the various packets in a Current Directory along
with displaying individual packet characteristics like Destination ID
and Transaction Code.

Sequence Box used to create a new sequence by first viewing desired
packets in the List of Asy Packets and clicking the left arrow to the
move the packet into the Sequence box.

Delay Enter a value for a delay in sending each packet.

Browse Click to navigate to find a previously created packet sequence.

Refresh Click to display the most current packets in the selected directory.

OK Click OK to close the window and return to the Data Generator
window.

Cancel Click to return to the Data Generator window without making any
changes.

Save Click to save to a file the selected changes made in the Asy
Sequence Editor window.

Generating Asynchronous Packets
To build and send a basic Asynchronous packet

1. On the Generator menu select the Data Generator command.

2. On the Asynchronous tab of the Data Generator window select the type of

packet to build from the Packet Type list.

3. Select from the Speed list the packet speed. For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

4. In the Header box, enter the Destination ID.  Depending upon the packet type,

enter, as needed, values for the other fields in the Header box.

5. If the packet type includes a payload, enter it in the Payload field.

6. On the Operation box click the Send button.  The Data Generator window

remains open.

7. As needed, build and send other packets.

To build and send an Asynchronous packet containing a payload

1. From the Packet Type list on the Asynchronous tab select the packet type that

contains a payload such as Read Quadlet Response, Write Quadlet Request,

Read Block Response, Write Block Request, etc.

2. From the Speed list select a packet speed. For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. In the Header box, specify the Destination ID and Destination Offset Low.

Depending upon the packet type, enter, as needed, values for the other fields in

the Header box.

4. In the Payload field enter a packet payload.  Enter the payload in hexadecimal.

The Data Length field in the Header section is updated automatically.

5. On the Operation box, click the Send or Send/Capture buttons.

6.2  Asynchronous Packet Generation



6-6 IM 703425-01E

To build and send an Asynchronous packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.

2. On the Asynchronous tab of the Data Generator window select the type of

packet to build from the Packet Type list.

3. From the Speed list select the packet speed. For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

4. In the Header box, enter the Destination ID.  depending upon the packet type,

enter, as needed, values for the other fields in the Header box.

5. If the packet type includes a payload, enter it in the Payload field.

6. Click the Setup Trigger button to set any desired trigger conditions.  For more

information on Trigger conditions, refer to the section, Capturing Packets.

7. On the Operation box click the Send/Capture button.  The Data Generator

window closes and the Capturing Data dialog box appears. data capture stops

when the capture buffer is full, the trigger condition is met, or the Stop button is

clicked.

To build and send an Asynchronous packet containing an incorrect Header CRC

or Payload CRC

1. Build an Asynchronous packet.

2. On the Asynchronous tab in the Header box, select Manual Overwrite.

3. In the Header CRC field enter an incorrect CRC value.

4. Option: to also include an incorrect payload CRC in the Payload box, select

Overwrite; in the CRC field enter an incorrect CRC value.

5. On the Operation box click the Send or Send/Capture buttons.

To build an Asynchronous packet and save to a file for later use

1. Build an Asynchronous packet.

2. In the Packet Name field in the Operation box, enter a file name for the packet.

3. Click Save.

To send an Asynchronous packet currently residing in the Event List

1. Scroll through the Event List window and double-click a packet on the Event List.

The Data Explorer window appears.

2. On the Data Explorer window click the Save Packet button.  The Save As dialog

box appears.

3. In the File name field enter a file name for the packet and click Save.

4. On the Data Explorer window click Close. The Data Explorer window closes.

5. From the Generator menu select the Data Generator command. The Data

Generator window appears.

6. On the Data Generator window select the Asynchronous tab.

7. In the Operation box click the Browse button. The Open dialog box appears.

8. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

9. Option: use the controls on the Data Generator window to modify the packet.

10. On the Operation box click the Send or Send/Capture buttons.

6.2  Asynchronous Packet Generation
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To load and send an Asynchronous packet saved to a file

1. On the Generator menu select the Data Generator command. The Data

Generator window appears.

2. On the Data Generator window select the Asynchronous tab.

3. In the Operation box click the Browse button. The Open dialog box appears.

4. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

5. Option: use the controls on the Data Generator window to modify the packet.

6. On the Operation box click the Send or Send/Capture buttons.

To build an Asynchronous packet and send it multiple times
Note

The Asynchronous Repeat option will send between 1-999 packets continuously and as fast

as possible.

1. Build an Asynchronous packet.

2. In the Repeat field on the Operation box, enter the number of times to send the

packet.

3. Option: in the Delay field on the Operation box enter the length of delay between

each packet transmission.

4. On the Operation box click the Send or Send/Capture buttons.

To specify the entire contents of an Asynchronous packet in hexadecimal

1. On the Packet Type list on the Data Generator window select RAW PACKET.

The name of the Payload box changes to Raw Data.

2. In the Raw Data field enter the packet contents in hexadecimal.

3. On the Operation box click the Send or Send/Capture buttons.

Sending Sequences of Asynchronous Packets
Use the Asynchronous Sequence Editor dialog box, which is accessed from the Data

Generator window, to create a sequence of packets saved to a file(s) that are sent

together.

To build and send a sequence of Asynchronous packets

1. Build an Asynchronous packet.

2. In the Packet Name field in the Operation box, enter a file name for the packet.

3. Click Save.

4. Repeat Steps 1 – 3 as needed.

5. Click the Build button in the Asy Packet Sequence section of the Data Generator

window.  The Asynchronous Sequence Editor dialog box appears. The left

window contains a list of all Asynchronous packets saved to a file in the default

folder.

6. Option: use the Browse button to search other folders.

7. To add a packet to the sequence, select it in the left list and click the  >> button.

8. To remove a packet from the sequence, select it in the right list and click the <<

button.

9. To save the sequence for later re-use, enter a name in the Sequence Name field,

and click Save.

10. Click OK.  The Asynchronous Sequence Editor dialog box closes.

11. On the Asy Packet Sequence box of the Data Generator window click the Send

or Send/Capture button.

6.2  Asynchronous Packet Generation
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To load and send a sequence of Asynchronous packets saved to a file(s)

1. On the Asy Packet Sequence box of the Data Generator window click the Browse

button.  The Open dialog box appears.

2. On the Open dialog box, select the packet sequence and click Open.

3. On the Operation box click Send or Send/Capture buttons.

6.2  Asynchronous Packet Generation
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6.3 Isochronous Packet Generation

Isochronous Packet Generation Overview
Using the controls on this tab, you can:

• Build an Isochronous packet with a user-defined payload with the CRC and Data

Length fields automatically updated

• Build an Isochronous packet containing a random pattern payload

• Send an Isochronous packet using any valid channel number

• Build a packet and save it for later use

• Send an Asynchronous packet (built using the controls on the Asynchronous tab)

along with each transmission of an Isochronous packet

• Build, send, and simultaneously capture an Isochronous packet or a sequence of

Isochronous packets

To open the data Generator window and select the Isochronous tab

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. On the Data Generator window click the Isochronous tab.

Tip

On the toolbar click the Data Generator button.

Data Generator Window: Isochronous Tab Controls
Use the controls on the Isochronous tab to generate a customized packet.

Data Generator Window Isochronous Tab

Item Description

Speed Select the speed to be used to send the packet.

Validate Bandwidth Use to insure that bandwidth is available (by interacting with the
check box Isochronous Resource Manager) before sending the packet.

Setup Trigger Display the Trigger window to select trigger conditions.  This is the same
window displayed when selecting New Capture from the Trigger menu.
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Header Box

Item Description

Data Length Specify the contents of the Data Length field in the packet.

Tag Data Format Tag.

Iso Channel Specifies the logical channel.

Tcode Transaction Code (0 x A).

sy Synchronization Code (application specific).

Header CRC Use this field to enter your own value for the Header CRC if the
adjacent Overwrite check box is checked.  If this field is grayed out
(that is, if the Overwrite box is not selected), the VK9000 uses the
correct CRC value.

Payload Box

Item Description

Payload field Use this field to enter the packet’s payload.  If the packet type
implies a fixed data length, then the appropriate number of bytes
must be entered.
Note: enter an even number of characters (that is, complete

bytes).  If an odd number of characters is entered, the
extra half byte is ignored.

Auto Payload Use to create randomly generated data to fill the packet’s payload.

Fill with Pattern Use to ignore the data in the Payload box and instead fill the packet
with a data pattern.

CRC Use this field to enter your own value for the Payload CRC if the
adjacent Overwrite check box is selected.  If this field is grayed out
(that is, if the Overwrite box is not selected), the VK9000 uses the
correct CRC value.

Operation Box

Item Description

Packet Name Save the specified packet to a file by entering a name and clicking
the Save button.
You can also open a saved packet by clicking the Browse button.

Save Click to save.

Browse Use to select an Isochronous packet saved to a file.

Send Asynch Packet with Iso Send one Asynchronous packet during each cycle.

Send/Capture Send the specified packet and enter capture mode.

Send Send the specified packet. The Data Generator window remains
open to specify and send additional packets.

Iso Streaming box

Item Description

Send/Capture Send all Isochronous packets in the Event List and enter capture
mode.  The packets are sent continuously.  To stop Iso Streaming,
select Stop Iso Streaming from the Generator menu, or click the
Stop Iso Streaming button on the toolbar.

Send Send all Isochronous packets in the Event List.  The packets are
sent continuously. The Data Generator window remains open to
specify and send additional packets. To stop Iso Streaming, select
Stop Iso Streaming from the Generator menu, or click the Stop Iso
Streaming button on the toolbar.

6.3  Isochronous Packet Generation



6-11IM 703425-01E

6

G
en

eratin
g

 1394 T
raffic

Generating Isochronous Packets
To build and send an Isochronous packet containing user-supplied data as the

payload

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears. Select the Isochronous tab.

2. From the Speed list select a packet speed.  For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. On the Header box, enter the Iso Channel and enter the desired length in the

Data Length field. As necessary, enter values for the other fields in the Header

box.

4. On the Payload box clear the Auto payload check box.

5. In the Payload field enter a hexadecimal packet payload.

6. Option: on the Isochronous tab select the Validate Bandwidth check box (the

VK9000 validates available bandwidth with the Isochronous Resource Manager

before sending the packet).

7. On the Operation box click Send.  The Data Generator window remains open to

build and send additional packets.

To build and send an Isochronous packet containing random data as the payload

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears. Select the Isochronous tab.

2. From the Speed list select a packet speed.  For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. On the Header box, enter the Iso Channel and enter the desired length in the

Data Length field. As necessary, enter values for the other fields in the Header

box.

4. On the Payload box select the Auto payload check box.

5. Option: On the Isochronous tab select the Validate Bandwidth check box (the

VK9000 validates available bandwidth with the Isochronous Resource Manager

before sending the packet).

6. On the Operation box click Send.  The Data Generator window remains open to

build and send additional packets.

To build and send an Isochronous packet containing a pattern as the payload

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears. Select the Isochronous tab.

2. From the Speed list select a packet speed.  For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. On the Header box enter the Iso Channel and enter the desired length in the Data

Length field. As necessary, enter values for the other fields in the Header box.

4. On the Payload box select the Auto payload check box and select the Fill with

Pattern check box.

5. Option: on the Isochronous tab select the Validate Bandwidth check box (the

VK9000 communicates with the Isochronous Resource Manager before sending

the packet).

6. In the Operation box click Send.  The Data Generator window remains open to

build and send additional packets.

6.3  Isochronous Packet Generation
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To build and send an Isochronous packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears. Select the Isochronous tab.

2. From the Speed list select a packet speed.  For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. On the Header box, enter the Iso Channel and enter the desired length in the

Data Length field. As necessary, enter values for the other fields in the Header

box.

4. On the Payload box select the Auto payload check box.  Option: in the Payload

box select the Fill with Pattern check box.

5. Option: on the Isochronous tab select the Validate Bandwidth check box (the

VK9000 communicates with the Isochronous Resource Manager before sending

the packet).

6. On the Isochronous tab click the Setup Trigger button.  The Trigger window

appears.

7. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

8. On the Operation box on the Isochronous tab click Send/Capture.  The Data

Generator window closes and the Capturing data dialog box appears.  The

Capturing Data dialog box remains open until the capture buffer is full, the trigger

condition is met or the Stop button is clicked.

To build an Isochronous packet and save to a file for later use

1. Build an Isochronous packet.

2. In the Packet Name field on the Operation box, enter a file name for the packet.

3. Click Save.

To send one Isochronous packet currently residing in the Event List

1. Scroll through the Event List window and double-click an Isochronous packet on

the Event List.  The Data Explorer window appears.

2. On the Data Explorer window click the Save Packet button.  The Save As  dialog

box appears.

3. In the File name field enter a file name for the packet and click Save.

4. On the Data Explorer window click Close. The Data Explorer window closes.

5. On the Generator menu select the Data Generator command. The Data

Generator window appears.

6. On the Data Generator window select the Isochronous tab.

7. On the Operation box click the Browse button. The Open dialog box appears.

8. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

9. Option: use the controls in the Data Generator window to modify the packet.

10. On the Operation box click the Send or Send/Capture buttons.

6.3  Isochronous Packet Generation
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To send all Isochronous packets in the Event List

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears. Select the Isochronous tab.

2. From the Speed list select a packet speed.  For speeds greater than 100 Mbps,

check the Topology Map to insure that the speed is supported along the entire

path between the VK9000 and the destination nodes.

3. To send the packets using a different Isochronous channel, enter a channel in the

Iso Channel field.

4. In the Iso Streaming box click the Send or Send Capture buttons.  The

Isochronous packets in the Event List window are repeatedly transmitted.

5. To stop Iso Streaming, from the Generator menu select the Stop Iso Generation

command.

Tip

• To stop Iso Streaming, on the toolbar click the Stop Iso Generation button.

To load and send an Isochronous packet saved to a file

1. On the Generator menu select the Data Generator command. The Data

Generator window appears.

2. On the Data Generator window select the Isochronous tab.

3. In the Operation box click the Browse button. The Open dialog box appears.

4. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

5. Option: use the controls in the Data Generator window to modify the packet.

6. In the Operation box click the Send or Send/Capture buttons.

To send one Asynchronous packet with each Isochronous packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the Asynchronous tab and build an Asynchronous packet. Do not click Send

or Send/Capture.

3. Click the Isochronous tab and build an Isochronous packet.

4. On the Operation box on the Isochronous tab select the Send Asynch

Streaming check box.

5. On the Operation box click the Send or Send/Capture buttons.

Note
Please off the software keyboard before Isochronous packet generate.

6.3  Isochronous Packet Generation
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6.4 PHY Packet Generation

PHY Packet Generation Overview
Using the controls on this tab, you can:

• Build and send PHY packets including Self ID, Link On, Configuration, Ping, Remote

Access, Remote Reply, Remote Command, Remote Confirmation, and Resume

• Change the Gap Count of all nodes on the bus

• Build a PHY packet and save it for later use

• Create (and optionally save for later use) a sequence of saved packets

To open the data Generator window and select the PHY tab

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. On the Data Generator window click the PHY tab.

Tip

• On the toolbar, click the Data Generator button.

Data Generator Window: PHY Tab Controls
Use the controls on the PHY tab to generate a customized packet.

Data Generator PHY Tab

Item Description

Packet Type Specify the type of packet to be generated.

Set Gap Set the gap count for the data Generator nodes to the specified value and
transmit a PHY Config packet with the specified gap count.

With Bus Reset When checked, a bus reset precedes each PHY packet sent.

Setup Trigger Display the Trigger window to specify trigger conditions.  This is the same
window displayed when selecting New Capture from the Trigger menu.
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Packet box

Item Description

Phy ID Specify the PHY ID (node) of the packet.

R check box If selected, the node specified by PHY ID will set its Force Root bit. (In case
of Phy config)

T check box If selected, all nodes will set their gap count to the value specified in Gap
Count. (In case of Phy config)

Gap Count Gap Count. (In case of Phy config)

Inverse of 1st quad Reserved for future use.

Type field Displays the packet type value. (In case of Remote Access, Remote
Command)

Page field Enter a Page value. (In case of Remote Acess)

Port field Enter a Port value. (In case of Remote Access, Remote Command)

Reg field Enter a Reg value. (In case of Remote Access)

Command list Select a command to send to a particular node. (In case of Remote
Command)

Operation box

Item Description

Packet Name Save the specified packet for future use by providing a name and clicking
the Save button.
Re-use a packet saved to a file by clicking the Browse button. For more
information refer to the Saving Captured Packets section.

Save Click to save.

Browse Click to browse for a packet.

Send/Capture Send the specified packet and enter capture mode.

Send Send the specified packet. The Data Generator dialog remains open to
specify and send additional packets.

PHY Streaming box

Item Description

Build Use this button to open the PHY Sequence Editor and then create a
sequence of saved packets that are then sent together.

Sequence Name Name of the sequence to send.

Send/Capture Send the specified sequence of packets and enter capture mode.

Send Send the specified packet. The Data Generator dialog remains open to
specify and send additional packets.

Browse Click to browse for a packet.

6.4  PHY Packet Generation
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Generating PHY Packets
To build and send PHY packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the PHY tab of the Data Generator window.

3. From the Packet Type list select the type of packet to build.

4. In the PHY ID field in the Packet box enter a source Id.

5. Option: in the Packet box select other values as needed.

6. Option: to precede a PHY packet with a bus reset, select the with bus reset check

box.

7. On the Operation box click the Send button.  The Data Generator window

remains open.

To build and send a PHY packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the PHY tab of the Data Generator window.

3. From the Packet Type list select the type of packet to build.

4. On the Packet box in the PHY ID field enter a Source ID.

5. Option: in the Packet box select other values as needed.

6. Option: to precede a PHY packet with a bus reset, select the with bus reset check

box.

7.  On the PHY tab click the Setup Trigger button.  The Trigger window appears.

8. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

9. In the Operation box click the Send/Capture button.

To build a PHY packet and save to a file for later use

1. Build a PHY packet.

2. In the Packet Name field on the Operation box, enter a file name for the packet.

3. Click Save.

To send a PHY packet currently residing in the Event List

1. Scroll through the Event List window and double-click a PHY packet on the Event

List.  The Data Explorer window appears.

2. On the Data Explorer window click the Save Packet button.  The Save As dialog

box appears.

3. In the File name field enter a file name for the packet and click Save.

4. On the Data Explorer window click Close. The Data Explorer window closes.

5. On the Generator menu select the Data Generator command. The Data

Generator window appears.

6. On the Data Generator window click the PHY tab.

7. In the Operation box click the Browse button. The Open dialog box appears.

8. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

9. Option: use the controls in the Data Generator window to modify the packet.

10. On the Operation box click the Send or Send/Capture buttons.

6.4  PHY Packet Generation



6-17IM 703425-01E

6

G
en

eratin
g

 1394 T
raffic

To load and send a PHY packet saved to a file

1. On the Generator menu select the Data Generator command. The Data

Generator window appears.

2. On the Data Generator window click the PHY tab.

3. In the Operation box click the Browse button. The Open dialog box appears.

4. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

5. Option: use the controls in the Data Generator window to modify the packet.

6. In the Operation box click the Send or Send/Capture buttons.

Sending Sequences of PHY Packets
Sending Sequences of PHY Packets Overview

Use the controls on the PHY Sequence Editor to select saved PHY packets and then

create a sequence of PHY packets that are sent together.

To build and send a sequence of PHY packets

1. Build a PHY packet.

2. In the Packet Name field on the Operation box, enter a file name for the packet.

3. Click Save.

4. Repeat Steps 1 – 3 as needed.

5. Click the Build button in the PHY Streaming box of the Data Generator window.

The PHY Sequence Editor dialog box appears. The left window contains a list of

all Asynchronous packets saved to a file residing in the default folder.

6. Option: use the Browse button to search other folders.

7. To add a packet to the sequence, select it in the left list and click the  >> button.

8. To remove a packet from the sequence, select it in the right list and click the <<

button.

9. To save the sequence for later re-use, enter a name in the Sequence Name field,

and click Save.

10. Click OK.  The PHY Sequence Editor dialog box closes.

11. In the PHY Streaming section of the Data Generator window click the Send or

Send/Capture button.

To load and send a sequence of PHY packets saved to a file(s)

1. On the PHY Packet Sequence box of the Data Generator window click the

Browse button.  The Open dialog box appears.

2. On the Open dialog box, select the packet sequence and click Open.

3. On the Operation box click Send or Send/Capture buttons.

6.4  PHY Packet Generation
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6.5 AV/C Packet Generation

Overview
To open the Data Generator window and select the AV/C tab

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. On the Data Generator window click the AV/C tab.

Tip

• On the toolbar, click the Data Generator button.

Data Generator Window: AV/C Tab Controls
Use the controls on the AV/C tab to customize AV/C packet generation.

Data Generator Window AV/C Tab

1394 Header box

Item Description

SrcID Enter a source ID.

DestID Enter a destination ID.

DestOffset Low Select a destination offset address for the packet.

Write Quad Req Select to generate a write quadlet request packet.

Write Block Req Select to generate a write block request packet.

Stream Data Select to generate a stream packet.
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FCP Frame box

Item Description

FCP Frame list Select an AV/C unit or subunit.

cts Displays the cts value (0 is the default value).

ctype check box and ctype list Select from the list a ctype.

response check box and Select from the list a response code.
response list

Subunit list Select from the list a Subunit.

Sub ID list Select a Subunit ID value (0-7).

Opcode field Enter an Opcode value in hexadecimal. (ex: 0X1F)

Operand0 field Enter an Operand value in hexadecimal. (ex: 0X3C)

Operand 1-n box Enter an Operand 1-n value in hexadecimal. (ex: 00002345)

Save Click to save.

Browse Click to browse for a packet.

Send/Capture Send the specified packet and enter capture mode.

Send Send the specified packet. The Data Generator dialog remains
open to specify and send additional packets.

Setup Trigger Display the Trigger window to select trigger conditions.  This is the
same window displayed when selecting New Capture from the
Trigger menu.

Generating AV/C Packets
To build and send an AV/C packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the AV/C tab of the Data Generator window.

3. Option: on the 1934 Header box on the AV/C tab enter a value in the Dest ID field.

4. Option: from the DestOffset list select a destination offset.

5. Select either the Write Quad Req or Write Block Req option buttons.

6. From the ctype list select an option.

7. On the FCP Frame box on the AV/C tab from the FCP list select an AV/C unit or

subunit.

8. Enter in the Sub ID field a value.

9. In the Opcode field enter a hexadecimal value.

10. Enter hexadecimal values in the Operand-1 and Operand-n fields.

11. Click Send. The Data Generator window remains open.

6.5  AV/C and IP Packet Generation
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To build and send an 1394 AV/C packet and simultaneously capture bus traffic

1. From the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the AV/C tab on the Data Generator window.

3. Option: on the 1934 Header box on the AV/C tab enter a value in the DestId field.

4. Option: from the DestOffset list select a destination offset.

5. Select either the Write Quad Req or Write Block Req option buttons.

6. From the ctype list select an option.

7. On the FCP Frame box on the AV/C tab from the FCP list select an AV/Cm unit or

subunit.

8. Enter in the Sub ID field a value.

9. In the Opcode field enter a hexadecimal value.

10. Enter hexadecimal values in the Operand-1 and Operand-n fields.

11. On the AV/C tab click the Setup Trigger button.  The Trigger window appears.

12. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

13. In the Operation box click the Send/Capture button.

To build an AV/C packet and save to a file for later use

1. Build an AV/C packet.

2. In the Packet Name field enter a file name for the packet.

3. Click Save.

To load and send an AV/C packet saved to a file

1. On the Generator menu select the Data Generator command. The Data

Generator window appears.

2. On the Data Generator window click the AV/C tab.

3. On the AV/C tab click the Browse button. The Open dialog box appears.

4. On the Open dialog box select a packet and click Open.  The packet information

appears in the Data Generator window.

5. Option: use the controls on the Data Generator window to modify the packet.

6. In the Operation box click the Send or Send/Capture buttons.

6.5  AV/C and IP Packet Generation
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6.6 IPv.4 Packet Generation Overview

Overview
To open the Data Generator window and select the IPv.4 tab

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. On the Data Generator window click the IPv4 tab.

Tip

• On the toolbar, click the Data Generator button.

Data Generator Window: IPv4 Tab Controls
Use the controls on the IP tab to customize IP packet generation.

Data Generator Window IPv.4 Tab

Item Description

Stream Data radio button Select to create a stream data packet.

Write Block Request radio Select to create a Write Block Request packet.
button

Load Data File button Click to load a data packet saved to a file.

Setup Trigger button Click to open the Trigger window.

Send button Click to send a packet without closing the Data Generator window.

Send/Capture button Click to generate and capture a packet.
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1394 Header box

Item Description

Data Length field Displays payload data length.

Tag field Enter Tag data information.

Channel field Enter Channel data information.

tCode Field Displays TCode information.

sy field Enter a Sync value.

Dest Offset Low field Enter a Destination Offset value.

SrcID field Displays Source ID information.

DestID field Enter Destination ID data.

By the Contents specified with IP Header box, it changes box which able to input.

IP Header box

Item Description

Unfragmented radio button Select to create an unfragmented IP packet.

Fragmented radio button Select to create a fragmented IP packet.

IP Packet list Select a packet type.

# of fragments field Specify the number of fragments for a packet.

dgl field Specify the dgl value for a packet.

These items under box menu are changed by the IP Header box selection.

IP Payload box

Item Description

Auto Payload check box Select to include an automatically generated payload value.

Payload Length field Displays the payload length.

IP Payload Display box Enter a payload value for the IP packet.

ARP box

Item Description

Opcode list Select an opcode for an ARP packet.

Sender_unicast_FIFO box Enter a sender_unicast_FIFO value for an ARP packet.

Sender_IP_addr field Enter a sender_IP_addr value for an ARP packet.

Target_IP_addr field Enter a target_IP_addr value for an ARP packet.

MCAP box

Item Description

Opcode list Select an opcode for an MCAP packet.

Payload Length field Displays the payload length for an MCAP packet.

IP Payload Display box Enter a payload value for an MCAP packet.

6.6  IPv.4 Packet Generation Overview
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Generating IP Packets
To build and send an IP packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button or the Write Block Request radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented or Fragmented radio button.

6. If Unfragmented was selected in step 5, on the IP Header box select IPv4 from

the list.

7. If Fragmented was selected, enter data in the # of fragments field and dgl field.

8. Option: on the IP Payload box select the Auto Payload check box.

9. Option: on the IP Payload box enter an IP payload.

10. Click the Send button.  The Data Generator window remains open.

To build and send an IP packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button or the Write Block Request radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented or Fragmented radio button.

6. If Unfragmented was selected in step 5 select on the IP Header box select IPv4

from the list.

7. If Fragmented was selected, enter data in the # of fragments field and dgl field.

8. Option: on the IP Payload box select the Auto Payload check box.

9. Option: on the IP Payload box enter an IP payload.

10. On the IPv4 tab click the Setup Trigger button.  The Trigger window appears.

11. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

12. Click the Send/Capture button. Data generation and capturing begins.

To build and send an ARP packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button or the Write Block Request radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented radio button.

6. On the IP Header box select ARP from the list.

7. On the ARP box select an option from the Opcode list and enter values in the

Sender_unicast_FIFO, Sender_IP_addr, and Target_IP_addr fields.

8. Click the Send button.  The Data Generator window remains open.

6.6  IPv.4 Packet Generation Overview
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6.6  IPv.4 Packet Generation Overview

To build and send an ARP packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button or the Write Block Request radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented radio button.

6. On the IP Header box select ARP from the list.

7. On the ARP box select an option from the Opcode list and enter values in the

Sender_unicast_FIFO, Sender_IP_addr, and Target_IP_addr fields.

8. On the IPv4 tab click the Setup Trigger button.  The Trigger window appears.

9. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

10. Click the Send/Capture button. Data generation and capturing begins.

To build and send an MCAP packet

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented radio button.

6. On the IP Header box select MCAP from the list.

7. On the MCAP box select an option from the Opcode list.

8. Option: on the IP Payload box enter a payload.

9. Click the Send button.  The Data Generator window remains open.

To build and send an MCAP packet and simultaneously capture bus traffic

1. On the Generator menu select the Data Generator command.  The Data

Generator window appears.

2. Click the IPv4 tab of the Data Generator window.

3. Select the Stream Data radio button.

4. On the 1394 Header box enter or select data in needed fields.

5. On the IP Header select the Unfragmented radio button.

6. On the IP Header box select MCAP from the list.

7. On the MCAP box select an option from the Opcode list.

8. Option: on the IP Payload box enter a payload.

9. On the IPv4 tab click the Setup Trigger button.  The Trigger window appears.

10. As needed, set trigger conditions and click OK.  The Trigger window closes and

the Data Generator window appears.  For more information on setting trigger

conditions, refer to the section, Capturing Packets.

11. Click the Send/Capture button. Data generation and capturing begins.
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7.1 Custom Protocol Plug-In Procedures Overview
(Optional)

The Custom Protocol Plug-In consists of two elements: the free Frame Builder software

which is used to create frame files and protocols and runs on any PC platform and the

Custom Protocol Plug-In which takes the data from the Frame Builder and parses it and

displays it in the Data Explorer window.

The Data Explorer in Protocols box displays two lines for loading protocols created in

the Frame Builder.

Note
The free Frame Builder is not installed in VK9000 without Customize option order at shipping.

Please install Frame Builder from backup CD-ROM when user will get this option separately.

Chapter 7 Additional VK9000 Software Functionality: Custom Protocol Plug-In and Scripting Engine
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7.2 Frame Builder Procedures Overview

To start the Frame Builder application

• Clicks Start from menu bar and select programs, Frame bilder.

To create a unique protocol containing at least one frame and field

1. In the Protocol box on the Frame Builder window, right-click and select Add.  The

Add New window appears.

2. On the Add New window on the Option box select the Protocol button.

3. In the Enter the name field enter a name for the protocol—for best results select a

name with four on less characters.  If needed, in the Enter revision field, enter a

revision number or name.

4. Click OK.

5. On the Protocol box, select the newly created protocol.

6. In the Protocol box on the Frame Builder window, right-click and select Add.  The

Add New window appears.

7. On the Add New window on the Option box select the Subset button.

8. In the Enter the name field enter a name for the subset—for best results select a

name with four on less characters.  If needed, in the Enter the revision field, enter

a revision number or name.

9. Click OK.

10. On the Protocol box, double-click the newly created protocol and select the newly

created subset.

11. In the Protocol box on the Frame Builder window, right-click and select Add.  The

Add New window appears.

12. On the Add New window on the Option box select the Frame button.

13. In the Enter the name field enter a name for the frame—for best results select a

name with four on less characters.  If needed, in the Enter the revision field, enter

a revision number or name.

14. Click OK.
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7.2  Frame Builder Procedures Overview

To add data to a unique protocol containing at least one frame and field

1. On the Protocol box, double-click the newly created protocol, double-click the

newly created subset, and select the newly created frame file.  Click the Go to

Frame button.  The Frame window appears.

2. On the Operation box, click the Insert button.

3. On the Field name box enter a name for the field.

4. On the Field length box enter a value in bits and if a constant value is desired

select the Is constant check box and enter a value in the Field constant value

box.

5. On the Display format box select a display value and click Apply.  The newly

created field appears in the display section of the Frame window.

6. If needed define and assign default values to a field by clicking the field in the

display section of the Frame window and click the Field button.  The Field window

appears.

7. On the Operation box click the Add radio button.

8. On the Value box enter a numeric value and on the Description box enter a

textual description.

9. On the Input Preference box click either the Decimal or Hex button.  Click Apply.

10. As needed define other field values and when finished click the Finish button.

To modify an existing protocol field and save it to a file

1. On the Protocol box, double-click the desired protocol, double-click a subset, and

select a frame file.  Click the Go to Frame button.  The Frame window appears.

2. On the Operation box, click the Edit button.

3. On the Field name box enter a name for the field.

4. On the Field length box enter a value in bits and if a constant value is desired,

select the Is constant check box and enter a value in the Field constant value

box.

5. On the Display format box select a display value and click Apply.  The newly

created field appears in the display section of the Frame window.

6. If needed define and assign default values to a field by clicking the field in the

display section of the Frame window and click the Field button.  The Field window

appears.

7. On the Operation box click the Edit radio button.

8. On the Value box enter a numeric value and on the Description box enter a

textual description.

9. On the Input Preference box click either the Decimal or Hex button.  Click Apply.

10. As needed define other field values and when finished click the Finish button.

To delete protocols, subsets, and frames

1. Select the protocol, subset or frame to delete.

2. Right-click the desired element and select Delete.

To export load protocol, frame, and field changes

• On the Frame Builder window click the Export button.
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To save changes/new protocol, frame, and field changes as default
Note

Use this feature carefully. Selecting it will permanently overwrite the factory default settings

that shipped with the unit and use instead the user entered data.

1. On the Frame Builder window click the Save as Default button.  The Frame

Builder dialog box appears.

2. Click Yes.

To load default settings that shipped with the software
Note

Use this feature carefully. Selecting it will erase any changes or new information added and

reset the factory settings.

1. On the Frame Builder window click the Load Default button.  The Frame Builder

dialog box appears.

2. Click Yes.

7.2  Frame Builder Procedures Overview
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7.3 Scripting API Overview

The purpose of a scripting language is to provide an easy-to-use method for users of a

Yokogawa Data Analyzer to set up their own automated test sequences. These scripts

run automatically with setting trigger conditions, generating packets, etc.

The system is based on a scripting package from Sax Software Corp. called Sax Basic

Engine Version 5.0. It provides all the flexibility and versatility of a standard Visual Basic

language. Additionally, the VB command set was extended to control the Data Analyzer

with intuitive commands defined in the Scripting API.

The Scripting API needed for supporting an effective Scripting Language can be

organized in seven different groups.

1. General

2. Data Management

3. Capture

4. Trigger

5. Generate

6. Combined

7. Miscellaneous

Review in detail in the following sections of document for a description of the various API

features.
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7.4 Scripting API: General

BusReset

Element Description

Prototype BusReset

Parameters none

Description Generates Bus Reset on Generator, i.e. generates  a complete list of SelfIDs
from all nodes on the bus

Return Value none

QueryPort

Element Description

Prototype QueryPort (nodeID, portID)

Parameters nodeID : defines node that shall be queried
portID   : defines port that shall be queried

Description Queries individual port for current port status

Return Value 00(binary), 0(decimal) - no info  available
01(binary), 1(decimal) - disabled
10(binary), 2(decimal) - suspended
11(binary), 3(decimal) – active

QueryAllPorts

Element Description

Prototype QueryAllPorts

Parameters none

Description Updates all ports on all nodes for current port status

Return Value none

UpdateEventList

Element Description

Prototype UpdateEventList

Parameters none

Description Updates Event List with last packet list

Return Value none

UpdateTopology

Element Description

Prototype UpdateTopology

Parameters none

Description Updates Topology with current Topology, no BusReset is generated in order to
capture SelfIDs

Return Value none
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7.5 Scripting API: Data Management

SavePacket

Element Description

Prototype SavePacket (“filename.*”)

Parameters filename.* : specifies filename for packet save

Description Saves active packet

Return Value TRUE if successful
FALSE if failed

SaveCapture

Element Description

Prototype SaveCapture (“filename.*”)

Parameters filename.* : specifies filename for capture save

Description Saves entire capture to file

Return Value TRUE if successful
FALSE if failed

SaveCaptureSequence

Element Description

Prototype SaveCaptureSequence (n, m, “filename.*”)

Parameters n : packet index of sequence start
m : packet index of sequence end
filename.* : specifies filename for capture save

Description Saves captured sequence from index n up to index m

Return Value SUCCESSFUL

OpenCapture

Element Description

Prototype OpenCapture (“filename.*”)

Parameters filename.* : specifies filename to be opened

Description Opens previously saved data file

Return Value TRUE if successful
FALSE if failed

SetActivePacket

Element Description

Prototype SetActivePacket (index)

Parameters index : specifies index of packet in packet list

Description Sets packet with index active

Return Value none

SetTriggeredPacketActive

Element Description

Prototype SetTriggeredPacketActive

Parameters none

Description Sets triggered packet to active packet

Return Value TRUE if successful
FALSE if failed



7-8 IM 703425-01E

FindPacket

Element Description

Prototype FindPacket (tcode, dir)

Parameters tcode : specifies tcode of packet to search for
dir : specifies the direction of search in packet list, i.e., 0 — up/ 1 – down

Description Finds next packet with matching tcode

Return Value 0 if fail to find the packet
packet index in packet list if successful

FindPacketPattern

Element Description

Prototype FindPacketPattern (quad_offset1, pattern1, quad_offset2, pattern2, logic, dir)

Parameters quad_offset1(Integer) : specifies offset (in quadlets) for pattern1 from packet
start
pattern1(String) : 8 Hex characters data pattern
quad_offset2(Integer) : specifies offset (in quadlets) for
pattern2 from packet start
pattern2 (String): 8 Hex characters data pattern
logic(Integer) : AND – 1 /OR — 0
dir(Integer) : direction of search, i.e. UP – 0 /DOWN – 1

Description Search for packet with matching data pattern as specified by bit pattern for 2
quadlets

Return Value Index of the packet,   if successful
0, otherwise

7.5  Scripting API: Data Management
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7.6 Scripting API: Capture

SetBufFill

Element Description

Prototype SetBufFill

Parameters none

Description Sets the buffer mode to Buffer Fill.

Return Value TRUE if successful
FALSE if failed

SetBufRot

Element Description

Prototype SetBufRot (n)

Parameters n : specifies buffer size, i.e. total number of packets in buffer

Description Sets the buffer mode to rotational Buffer.

Return Value TRUE if successful
FALSE if failed

IgnoreCycleStart

Element Description

Prototype IgnoreCycleStart

Parameters none

Description Disables logging of Cycle Start

Return Value TRUE if successful
FALSE if failed

EnableCycleStart

Element Description

Prototype EnableCycleStart

Parameters none

Description Enables logging of Cycle Start

Return Value TRUE if successful
FALSE if failed

DisableIso

Element Description

Prototype DisableIso

Parameters none

Description Disables logging of isochronous packets

Return Value TRUE if successful
FALSE if failed

EnableIso

Element Description

Prototype EnableIso

Parameters none

Description Enables logging of isochronous packets

Return Value TRUE if successful
FALSE if failed
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StartCapture

Element Description

Prototype StartCapture

Parameters none

Description Starts logging data.

Return Value TRUE if successful
FALSE if failed

StartCaptureNumber

Element Description

Prototype StartCaptureNumber (number)

Parameters number : total number of packets to be captured

Description Starts logging data until a total of number packets are captured. Captured will
be terminated, script will continue.

Return Value TRUE if successful
FALSE if failed

StartCaptureTrigger

Element Description

Prototype StartCaptureTrigger

Parameters none

Description Starts logging data with active trigger. Trigger must be defined in previous script
statement. Will stop if triggered, script will resume.

Return Value TRIGGERED

StopCapture

Element Description

Prototype StopCapture

Parameters none

Description Stops logging data. Active packet is first packet in packet list

Return Value TRUE if successful
FALSE if failed

7.6  Scripting API: Capture
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7.7 Scripting API: Trigger

SetTrigger

Element Description

Prototype SetTrigger (“triggername.*”)

Parameters triggername.* : specifies trigger file to be opened

Description Opens previously saved trigger file and arms trigger

Return Value TRUE if successful
FALSE if failed

SetTriggerCurrent

Element Description

Prototype SetTriggerCurrent

Parameters none

Description Arms trigger with current settings in the trigger window

Return Value TRUE if successful
FALSE if failed

ClearTrigger

Element Description

Prototype ClearTrigger

Parameters none

Description Clears all trigger settings

Return Value TRUE if successful
FALSE if failed

Comment New trigger set will clear previous trigger settings
Each script shall start with ClearTrigger as default

IsTriggered

Element Description

Prototype IsTriggered

Parameters none

Description Test if triggered on any packet

Return Value TRUE if  triggered
FALSE otherwise

ClearIsTriggered

Element Description

Prototype ClearIsTriggered

Parameters none

Description Clears IsTriggered condition

Return Value TRUE successful
FALSE otherwise
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7.8 Scripting API: Generator

GenerateActive

Element Description

Prototype GenerateActive (repeat, delay)

Parameters repeat : specifies how often this packet is generated
delay : time delay between repeats

Description Generates active packet from packet list repeat times

Return Value TRUE if successful
FALSE if failed

GenerateAsync

Element Description

Prototype GenerateAsync (“packetname.*”, repeat, delay)

Parameters packetname.* : specifies packet name to be opened
repeat : specifies how often this packet is generated
delay : time delay between repeats

Description Generates individual asynchronous packet (previously saved) n times

Return Value TRUE if successful
FALSE if failed

GenerateIso

Element Description

Prototype GenerateIso

Parameters none

Description Generates stream of isochronous packet with same payload

Return Value TRUE if successful
FALSE if failed

GenerateAsyncSeq

Element Description

Prototype GenerateAsyncSeq (“seqname.*”, repeat, delay )

Parameters packetname.* : specifies packet name to be opened
repeat : specifies how often this packet is generated
delay : time delay between repeats

Description Generates sequence of asynchronous packets

Return Value TRUE if successful
FALSE if failed

StopGenerateIso

Element Description

Prototype StopGenerateIso

Parameters none

Description Stop generating stream of isochronous packet

Return Value TRUE if successful
FALSE if failed
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7.9 Scripting API: Combined

StartCapture_GenerateActive

Element Description

Prototype StartCapture_GenerateActive(repeat, delay)

Parameters repeat : specifies how often this packet is generated
delay : time delay between repeats

Description Starts logging data and will immediately commence generation of active packet

Return Value TRUE if successful
FALSE if failed

StartCapture_GenerateAsync

Element Description

Prototype StartCapture_GenerateAsync(“packetname.*”, repeat, delay)

Parameters packetname.* : specifies packet name to be opened
repeat : specifies how often this packet is generated
delay : time delay between repeats

Description Starts logging data and will immediately commence generation of async packet

Return Value TRUE if successful
FALSE if failed

StartCapture_GenerateIso

Element Description

Prototype StartCapture_GenerateIso

Parameters none

Description Starts logging data and will immediately commence generation of isochronous
stream

Return Value TRUE if successful
FALSE if failed

StartCapture_GenerateAsyncSeq

Element Description

Prototype StartCapture_GenerateAsync  (“sequencename.*”, repeat, delay)

Parameters sequencename.* : specifies sequence name to be opened

repeat : specifies how often sequence is generated

delay : time delay between repeats

Description Starts logging data and will immediately commence generation of async
sequence

Return Value TRUE if successful
FALSE if failed
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7.10 Scripting API: Miscellaneous

Delay

Element Description

Prototype Delay(time)

Parameters time : specifies how many milliseconds needed to delay

Description Delays time milliseconds

Return Value none
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7.11 Examples

Script1
BusReset, define capture settings, capture packets, update Event List and Topology

Map.

SetBufRot

ClearTrigger

SetBufFill

BusReset

IgnoreCycleStart

DisableIso

StartCapture

StopCapture

UpdateTopology

UpdateEventList

Script2
Capture with armed trigger loaded from trigger file test1.trg.

SetBufRot

ClearTrigger

SetTrigger(“test1.trg”)

StartCapture

StopCapture

UpdateEventList

Script3
Start capture with armed trigger, find packet with bit pattern before trigger, start capture

with different trigger, regenerate packet with certain bit pattern, if triggered generate

async sequence 20 times while triggering on another packet.

SetBufRot

ClearTrigger

SetTrigger(“test1.trg”)

StartCapture

StopCapture

FindPacketPattern(0,”FFFF0123”,1,”AAAA0123”,AND,UP)

SetActivePacket(index)

SetTrigger(“test2.trg”)

StartCaptureTrigger_GenerateActive

SetTrigger(test3.*)

StartCaptureTrigger_GenerateAsyncSeq(“test.seq”,20,0)

UpdateEventList
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Script4
Start Capture with armed trigger (Phy Packet), Loop creating 5 BusResets , if triggered

successful generate Async. test sequence and clear IsTriggered status, if not triggered

on bus Reset change trigger condition to lock request and generate async. Lock Request

packet (twice with delay), if triggered generate test sequence (repeat twice).

SetBufRot

ClearTrigger

SetTrigger(“PhyTrig.trg”)

StartCapture

For n = 1 To 5, Step 1

BusReset

Next n

If IsTriggered Then

GenerateAsyncSeq(“test.asq,1,0)

ClearIsTriggered

Else

SetTrigger(“Lock.trg”)

GenerateAsyn(“Lock.apk”,2,10)

If Is Triggered Then

GenerateAsyncSeq(“test.asq”,2,0)

End If

End If

StopCapture

UpdateEventList

7.11  Examples
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8.1 Contacting Customer Support

For technical support on this product please contact your local Yokogawa distributor or:

North America:
Yokogawa Corporation of America

Phoenix Technology Center

Phone: +1-480-783-8990

Fax: +1-480-783-0209

Email: 1394support@yca.com

Europe:
Yokogawa Europe B.V.

Phone: +31-33-4641-670

Fax: +31-33-4641-659

Japan and Others :
Yokogawa Electric Corporation

Test and Measurement Division Communication Product Sales

Phone: +81-422-52-5556

Fax:+ 81-422-52-6624

E-mail:da1394@csv.yokogawa.co.jp

Chapter 8 Contacting Customer Support, Backup Software Installation, and Troubleshooting Tips
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8.2 Backup Software Installation

The VK9000 was shipped with a licensed copy of Windows NT on CD-ROM.  It is

provided in case it ever becomes necessary to re-install Windows NT.  Do not lose or

misplace your copy.

The VK9000 was also shipped with a backup copy of the VK9000 software on either CD-

ROM or floppy disk.  If it becomes necessary to re-install the software, contact

Yokogawa or your local distributor.

Note
The VK9000 software will run only the hardware platform installed with the unit.
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8.3 Common Troubleshooting Tips

Touchscreen Troubleshooting Tips
Problem:

Lighting for the LCD Monitor becomes dim or dark. Monitor lighting often relates to the

VK9000’s inverter card.

Solution:

1. Exit all applications and turn OFF the instrument.  Do not use the VK9000 for

approximately 10-15 minutes.

2. Turn ON the unit.

3. If the lighting for the LCD Monitor still remains dim the unit’s inverter card is most

likely malfunctioning.  Contact your nearest Yokogawa dealer for customer support.

If the lighting for the LCD Monitor is dark, then the inverter card has most likely

failed.  Contact your nearest Yokogawa dealer for customer support.

Problem:

Touchscreen does not respond when pressed. Check and change the COM Port Setting.

Solution:

1. On your desktop click the Start button and select Settings.  From the Settings

menu select Control Panel.  The Control Panel window appears.

2. On the Control Panel window double-click ELO Touchscreen icon.  The ELO

Touchscreen window appears.

3. On the General tab of the ELO Touchscreen window make sure that the

Touchscreen is configured to use COM Port 1.  If the setting is incorrect change it

to COM Port 1.

4. Click OK.

Note
If your VK9000’s body colord green, please use COM Port3.

Problem:

When an icon on the Touchscreen is pressed, the action does not occur, or the action

occurs if an area around the icon is pressed. Touchscreen is improperly calibrated.

Change or adjust the calibration.

Solution:

1. On your desktop click the Start button and select Settings.  From the Settings

menu select Control Panel.  The Control Panel window appears.

2. On the Control Panel window double-click ELO Touchscreen icon.  The ELO

Touchscreen window appears.

3. On the General tab of the ELO Touchscreen window click the Calibrate button.

Follow the onscreen prompts, which call for pressing different sections of the LCD

screen.  When finished click OK.

Keyboard Usage Troubleshooting Tips
Problem:

Keyboard does not respond as anticipated.  When a specific key is pressed a different

letter, number, or symbol appears. The FN Key has been enabled by most likely the user

accidentally pressing it.

Solution:

• Press the FN Key to disable.  The keyboard will return to normal functioning.
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8.3  Common Troubleshooting Tips

Topology Map / Node Information Display Troubleshooting Tips
Problem:

When connecting another device to the VK9000, node information is not displayed on

the Topology Map. Implement a time delay to allow all devices textra time to respond to

the VK9000’s Read Quadlet Request command.

Solution:

1. On the File menu select Preferences and from the Preferences submenu select

the Refresh Topology with Time Delay command.  The Time Delay window

appears.

2. On the Time Delay window on the Time box enter a value of at least 10

milliseconds.

3. Click OK.

4. On the Trigger menu select the Refresh Topology command.  A Bus Reset

occurs.  The missing node information will appear.  If it does not appear after the

Bus Reset, repeat the step and increase the value in the Time box by at least 10

milliseconds.

Problem:

When connecting another device to the VK9000, node information is not displayed on

the Topology Map.  The device in particular might have implemented a setup in which

the device’s Link is software powered, which means that the device must be turned ON

to awaken the Link which will in turn allow for device information display on the VK9000’s

Topology Map.

Solution:

• Turn ON device.
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9.1 Main Specification (dpx ver 1.2)

Item Specification

Analysis Functions Live Topology Analysis
Transmission Analysis
Timing Analysis
Statistical Analysis
Trigger and Filter Functions
Real-time Bus Bandwidth Monitoring

Analyzer Input/Output External Trigger
Ethernet 100BaseT
2 × USB 1.0 (Master)
CRT (ext. Monitor)
S-Video
2 × PS2 (Mouse, Keyboard)
4 × Serial
1 × Parallel
12/5 V DC Out
100/220 V AC Power In

Display 14.1” Color TFT

Weight 9.53 kg

Dimensions 68 × 321 × 72 mm (W × H × D)

Operating Temperature 0 to 50°C

Relative Humidity 10~95%. non-condensing

Shock 10G peak acceleration

IEEE1394 Device Specification

Item Specification

1394 Compliance Level IEEE 1394-1995, IEEE 1394-2000 (physical layer)

1394 Transfer Speeds 100 Mbps, 200 Mbps, 400 Mbps

Number of 1394 Nodes 1

Number of 1394 Ports 3 (2 × 6-pin, 1 × 4-pin)

Packet Generation Isochronous (max. 4096 Byte @ 400 Mbps)
Asynchronous (max. 2048 Byte @ 400 Mbps)
Physical layer packets (basic and extended)

Configurable 1394 Cable Class 1 (15 Ω @ 12 V)
Power Provider Class 5 self-powered (no cable power provider and consumer)

Phy Test Mode Reduced SCLOCK rate, 1/32 @S400, 1/16 @ S200 and 1/8 @ S100 (Not available ver 1.2).

Standard Device Capabilities Root
Isochronous capable (isc)

Selectable Device Capabilities Cycle Master (CM)
Isochronous Resource Manager (IRM)
Bus Manager (BM)

ConfigROM Compliance Level ISO/IEC 13213 (ANSI/IEEE Std 1212), P1212r

Clock Accuracy 25 ppm

Port Operations Disable/Enable, Suspend/Resume

Chapter 9 VK9000 Specification
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Analyzer

Item Specification

Data Capture Memory 128 MB (shared with OS)

Buffer Organization Rotational or Buffer Fill

Bus Transaction Analysis
Event Display Items Type (including protocol decoding information), Index, Time, Tcode, ExtTcode, SrcID, DestID,

DstAddr, Tlabel, Retry, Resp, Priority, Speed, Channel, Tag, Sync, Ack, Data Length)
Packet Timestamp
(rendered in sec:cycles:ticks or millsec:microsec:nanosec
Display in absolute or delta values, roll-over period 16.6 min

Packet Display Isochronous (Stream)
Asynchronous (Write Quadlet Request, Write Block Request, Write Response, Read Quadlet
Request, Read Block Request, Read Quadlet Response, Read Block Response, Lock Request,
Lock Response Cycle Start)
Acknowledge
Physical Layer packets (SelfID, Phy Config, Link On Ping, Remote Access, Remote Command,
Resume, Remote Reply, Remote Confirmation, Resume)

Error Analysis Transmission Truncation
Header CRC Verification
Payload CRC Verification
DMA Error

Real-time Monitors Bandwidth monitor with sampling period values of .1, .5 and 1 sec.

Topology Analysis Live bus topology display
Speed map display
Port connection status indicator (Active, Suspended, Disabled, Disconnected)
Bus Info Block Display
Node Icon Display
Display Protocol functionality on remote nodes (IEC61883; (optional) SBP-2, IPv4, AV/C etc.)

ConfigROM Explorer Node ConfigROM Decode and Verification of ISO/IEC 13213 (ANSI/IEEE Std 1212) and P1212r
compliance

9.1  Main Specification
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Trigger

Item Specification

Trigger condition Setting
Arming trigger Configurable based on event traffic
Pre/Post trigger setting Configurable based on event traffic
Trigger Condition Bit pattern matching

Packet header matching (tcode, srcID, destID, Address etc.)
Packet Payload Patterns
Errors (Header CRC, Payload CRC, Truncation )
Pre-defined Payload Patterns for Protocol (AV/C, IPv4)

Sequential trigger 3 stages deep
Statistical trigger Log events without stopping data capture
External Trigger I/O BNC connector configurable for:

Trigger In
Input Impedance:
1 Meg Ω (-0.3 Vdc < Vin < 3.6 Vdc)
4.7 K Ω ( Vin < –0.3 Vdc or Vin >3.6 Vdc)
Max input: +/- 20 Vdc
Minimum Pulse Width: 20 nS
Positive Threshold: 2.0 V Nominal 2.5 V Max
Negative Threshold: 1.2 V Nominal 0.8 V Min
Input Logic: positive logic
Input Latency: 10 ns

Trigger Out
Output Level: CMOS=3.2
24 mA
Output Impedance: 50 Ω
Positive Logic: Rising Edge = Trigger
Rise Time: 2.5 nS
Logic Low: 0.55 V @ 25 mA
Logic High: 2.5 V @ –25 mA (Standard)
Logic High: 4.0 V @ 25 mA (Optional)
Pulse Width: 150 nS
Output Latency: max. 200 ms

External Clock Output (Not available ver 1.2)
Rising Clock Edge: 2.5 ns
Output impedance: 50 Ω
Logic Low 0.55V @ 25m A
Logic High 2.5 @ –25m A
Optional Configuration as shipped from Factory:
Logic Low 0.55 V @ 25 mA
Logic High 4.0 @ –25 mA

Real-Time Filter

Item Specification

Packet matching Filter Isochronous packets and Cycle Start

Post-Capture Filter

Item Specification

Data Filter Tcode, ExtTcode, SrcID, DestID, DstAddr, Data Length

Post-Capture Search

Item Specification

Data Search Index, Tcode, ExtTcode, SrcID, DestID, DstAddr, Tlabel, Retry, Resp, Priority, Speed, Channel,
Tag, Sync, Ack, Data Length, Data Error, Trigger

9.1  Main Specification
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Time Analysis

Item Specification

Bandwidth Chart
Time axis (horizontal) Bus Cycles
Time resolution 125ms
Bus Utilization (vertical) Transmission times
Utilization resolution 40.7 ns

Data Generator

Item Specification

CSR Access CSR register access with Read/Write/Lock commands send as either Read Quadlet or Read
Block request
Speed: 100 Mbps

Traffic Generator
Packets Asynchronous packet or sequences generation

Isochronous sequences generation
Phy packet or sequence generation
All at speed of 100, 200, 400 Mbps

Error Header CRC overwrite, Data CRC overwrite
Asynchronous, Isochronous, and Phy packets
Speed 100, 200, 400 Mbps

9.1  Main Specification
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Advanced SW Modules

Item Specification

Protocol Plug-ins
AV/C (optional) Packet Decode, Command/Response Generation, Command/Response Trigger

Supported Specifications:
General ver. 3.0
VCR Subunit Specification ver. 2.0.1
Monitor Subunit Model and Command Set ver. 1.0
Tape Subunit Model and Command Set ver. 1.0
Customizable and extendable with Framebuider software

SBP2 (optional) Packet and Handshake Decode
Supported Specifications:
ANSI NCITS 325 1998
Customizable with Framebuider software

IPv4 (optional) Packet Decode, ARP/MCAP Generation, ARP/MCAPTrigger, Defragmentation
Supported Specifications:
Draft-IETF-IP1394-IPv4-19
Customizable and extendable with Framebuider software

HAVi (optional) Packet Decode
Supported Specifications:
HAVi 1.0
Customizable and extendable with Framebuider software

IEC-61883 1-4 Packet Decode
Supported Specifications:
IEC 61883-x 1.0
Customizable and extendable with Framebuider software

Custom1 (optional) Packet Decode
User defined with Framebuider software

Custom2 (optional) Packet Decode
User defined with Framebuider software

Scripting (optional) VB Scripting Engine
37 API calls for atomization of analyzer operations and functions

Data Viewer
Stand-alone application for remote PCs only

Remote Data viewing of captured traces including Filter and Search functions
Off-line Topology and Speed map analysis
Protocol decoding reflects protocols plug-ins in use at time of capture on VK9000
Supported operating systems: Win95, Win98, WinME, WinNT, Win2000

Framebuilder
Stand-alone application Runs on VK9000 and remote PCs (for operating system support see Data Viewer)

Unlimited 1394 packet payload decoding rules construction
Structured in predefined protocol tree featuring AV/C, SBP-2, IP, HAVi, IEC
Factory defined frame defaults (user changeable and extendable)

9.1  Main Specification
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Appendix.1 Protocol Support Detection Values

Protocol Field Location (24-bit immediate value) Value Note

SBP-2 Unit Spec ID First octet (byte) 0016

(SBP2) Second octet 6016 *1

Third octet 9E16

SW Version First octet 0116

Second octet 0416

Third octet 8316

IPv4 Unit Spec ID First octet 0016

(IPv4) Second octet 0016

Third octet 5E16

SW Version First octet 0016

Second octet 0016

Third octet 0116

IEC61883 Unit Spec ID First octet 0016

(IEC) Second octet A016

Third octet 2D16

SW Version First octet 0116 *2

AV/C Unit Spec ID Same as IEC61883

(AVC) SW Version First octet 0116

Second octet 0016

Third octet 0116

HAVi Unit Spec ID Same as IEC61883

(HAVi) SW Version First octet 0116

Second octet 0016

Third octet 0816

1: Due to a limited space on a node display box, protocol names will be displayed as in parentheses.
2: The second and third octets are reserved for AV/C, HAVi, and other protocols. E.g. if a node supports AV/C protocol, both

‘IEC’ and ‘AVC’ will be displayed

Appendix
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Appendix.2 Reference

Standards relevant to the analyzer.

IEEE 1394-1995
IEEE Std 1394-1995

IEEE Standards for a High Performance Serial Bus

IEEE 1394-2000
IEEE Std 1394-2000

IEEE 1212
ISO/IEC 13213: 1004 [ANSI/IEEE Std 1212, 1994 Edition]

Information technology - Microprocessor systems – Control and Status Registers (CSR)

Architecture for microcomputer buses

Upper Layer Protocol
AV/C Protocol

AV/C Digital Interface Command Set General Specification Version 3.0, April 15, 1998

FCP

Function Control Protocol (FCP) defined by IEC 61883

SBP-2 Protocol

Working Draft T10 Project 1155D Revision 4

Information technology – Serial Bus Protocol 2 (SBP-2)

IP over 1394 related documents

IEFT Internet-Drafts

IPv4 over IEEE 1394

Multicast Channel Allocation Protocol (MCAP) for IEEE 1394

DHCP for IEEE 1394

Transmission of IPv6 Packets over IEEE 1394 Networks
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